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Terms and Acronyms

The following table defines acronyms used in this deployment guide. When applicable, a Request for Change (RFC) is
included in the Definition column for your reference.

Acronym
CA
CSvV
DLP
DNS
DPD
GRE
ICMP
IdP
IKE
IPS
IPSec
PFS
PSK
SaaS
SSL
TLS
VDI
XFF
ZPC
ZDX
ZIA
ZPA

Definition

Central Authority (Zscaler)
Comma-Separated Values

Data Loss Prevention

Domain Name Service

Dead Peer Detection (RFC 3706)
Generic Routing Encapsulation (RFC2890)
Internet Control Message Protocol
Identity Provider

Internet Key Exchange (RFC2409)
Intrusion Prevention System
Internet Protocol Security (RFC2417)
Perfect Forward Secrecy
Pre-Shared Key

Software as a Service

Secure Socket Layer (RFC6101)
Transport Layer Security

Virtual Desktop Infrastructure
X-Forwarded-For (RFC7239)
Zscaler Posture Control (Zscaler)
Zscaler Digital Experience (Zscaler)
Zscaler Internet Access (Zscaler)
Zscaler Private Access (Zscaler)

©2024 Zscaler, Inc. All rights reserved.
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Trademark Notice

© 2024 Zscaler, Inc. All rights reserved. Zscaler™ and other trademarks listed at zscaler.com/legal/trademarks are either (i)
registered trademarks or service marks or (i) trademarks or service marks of Zscaler, Inc. in the United States and/or other
countries. Any other trademarks are the properties of their respective owners.
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About This Document

The following sections describe the organizations and requirements of this deployment guide.

Zscaler Overview

Zscaler (NASDAQ: ZS) enables the world's leading organizations to securely transform their networks and applications for
a mobile and cloud-first world. Its flagship Zscaler Internet Access (ZIA) and Zscaler Private Access (ZPA) services create
fast, secure connections between users and applications, regardless of device, location, or network. Zscaler delivers its
services 100% in the cloud and offers the simplicity, enhanced security, and improved user experience that traditional
appliances or hybrid solutions can't match. Used in more than 185 countries, Zscaler operates a massive, global cloud
security platform that protects thousands of enterprises and government agencies from cyberattacks and data loss. To
learn more, see Zscaler’s website.

Cimcor Overview

Cimcor develops innovative, next-generation compliance and system integrity monitoring software. The CimTrak Integrity
Suite monitors and protects a wide range of physical, network, cloud, and virtual IT assets in real time while providing
detailed forensic information about all changes. CimTrak helps reduce configuration drift and ensure that systems are in a
secure and hardened state. Securing your infrastructure with CimTrak helps you get compliant and stay that way. To learn
more, refer to Cimcor’s website.

Audience

This guide is for network administrators, endpoint and IT administrators, and security analysts responsible for deploying,
monitoring, and managing enterprise security systems. For additional product and company resources, see:

Zscaler Resources

Cimcor Resources

Appendix A: Requesting CimTrak Support

Appendix B: Requesting Zscaler Support

Software Versions

This document was authored using the latest version of Zscaler software.

Request for Comments

For prospects and customers: Zscaler values reader opinions and experiences. Contact partner-doc-support@
zscaler.com to offer feedback or corrections for this guide.

For Zscaler employees: Contact z-bd-sa@zscaler.com to reach the team that validated and authored the
integrations in this document.

©2024 Zscaler, Inc. All rights reserved. 7


https://www.nasdaq.com/market-activity/stocks/zs
http://www.zscaler.com
https://www.cimcor.com/
mailto:partner-doc-support%40zscaler.com?subject=
mailto:partner-doc-support%40zscaler.com?subject=
mailto:z-bd-sa%40zscaler.com?subject=

ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

Zscaler and Cimcor Introduction

Overviews of the Zscaler and Cimcor applications are described in this section.

If you are using this guide to implement a solution at a government agency, some of the content might be
different for your deployment. Efforts are made throughout the guide to note where government agencies might
need different parameters or input. If you have questions, contact your Zscaler Account team.

ZIA Overview

ZIA'is a secure internet and web gateway delivered as a service from the cloud. Think of ZIA as a secure internet on-
ramp—just make Zscaler your next hop to the internet via one of the following methods:

Setting up a tunnel (GRE or IPSec) to the closest Zscaler data center (for offices).
Forwarding traffic via our lightweight Zscaler Client Connector or PAC file (for mobile employees).

No matter where users connect—a coffee shop in Milan, a hotel in Hong Kong, or a VDI instance in South Korea—they get
identical protection. ZIA sits between your users and the internet and inspects every transaction inline across multiple
security techniques (even within SSL).

You get full protection from web and internet threats. The Zscaler cloud platform supports Cloud Firewall, IPS,
Sandboxing, DLP, and Isolation, allowing you to start with the services you need now and activate others as your needs
grow.

ZPA Overview

ZPA is a cloud service that provides secure remote access to internal applications running on a cloud or data center using
a Zero Trust framework. With ZPA, applications are never exposed to the internet, making them completely invisible

to unauthorized users. The service enables the applications to connect to users via inside-out connectivity rather than
extending the network to them.

ZPA provides a simple, secure, and effective way to access internal applications. Access is based on policies created by
the IT administrator within the ZPA Admin Portal and hosted within the Zscaler cloud. On each user device, software
called Zscaler Client Connector is installed. Zscaler Client Connector ensures the user’s device posture and extends a
secure microtunnel out to the Zscaler cloud when a user attempts to access an internal application.

Zscaler Resources

The following table contains links to Zscaler resources based on general topic areas.

Name Definition

ZIA Help Portal Help articles for ZIA.

ZPA Help Portal Help articles for ZPA.

Zscaler Tools Troubleshooting, security and analytics, and browser extensions that help
Zscaler determine your security needs.

Zscaler Training and Certification Training designed to help you maximize Zscaler products.

Submit a Zscaler Support Ticket Zscaler Support portal for submitting requests and issues.

©2024 Zscaler, Inc. All rights reserved. 8
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The following table contains links to Zscaler resources for government agencies.

Name Definition

ZIA Help Portal Help articles for ZIA.

ZPA Help Portal Help articles for ZPA.

Zscaler Tools Troubleshooting, security and analytics, and browser extensions that help
Zscaler determine your security needs.

Zscaler Training and Certification Training designed to help you maximize Zscaler products.

Submit a Zscaler Support Ticket Zscaler Support portal for submitting requests and issues.
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CimTrak Overview

CimTrak is an integrity assurance and compliance solution that detects changes (additions, modifications, or deletions)
in real time to files, directories, configurations, registries, ports, users, groups, and other critical system components across
a variety of application use cases, including servers, network devices, hypervisors, containers, cloud configurations,
database schemas, active directory, and more. CimTrak can then determine if those changes are good or bad.

CimTrak’s rollback capability enables it to revert to a previously trusted state in the event of malicious or
circumvented changes. This functionality is coupled with CimTrak’s ability to deny change(s) from occurring entirely.

CimTrak also leverages the best practices of both DISA STIGs and CIS Benchmarks to determine if a system, device,
application, or operating system is in a trusted and hardened state. When integrity drift is detected by CimTrak, it
provides the description, assessment, rationale, impact, and remediation capability to ensure trust and resiliency
throughout the enterprise.

CimTrak supports regulatory compliance with continuous detailed reporting and auditing features and integrates
seamlessly with other security and management systems, including Zscaler.

CimTrak is the only solution that can fully meet Zero Trust Tenet #5's expectations and objectives as defined by NIST
SP 800-207.

Cimcor Resources

The following table contains links to Cimcor support resources.

Name Definition

CimTrak/Zscaler Info Information and videos on CimTrak and Zscaler integration.

Submit a CimTrak Support Ticket CimTrak Support ticket entry form.

CimTrak ReadMe Docs CimTrak user documentation for install, configuration, and deployment.
CimTrak Support Portal CimTrak Knowledge Base and Support ticket management.

PDF Download Link White paper for CimTrak and ZPA.

PDF Download Link White paper for CimTrak and ZIA.

©2024 Zscaler, Inc. All rights reserved. 10
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Integrations Summary

The following table shows a summary of the Zscaler and Cimcor integrations.

Integration Name
ZPA Integrity Monitoring
ZPA Compliance Trigger

ZPA Integrity Trigger

ZIA Integrity Monitoring

ZIA Compliance Trigger

ZIA Integrity Trigger

Description of Integration

Allows users to monitor, baseline, alert, and roll back ZPA
configuration changes.

Allows users to automate enabling and disabling Zscaler
policies based on CimTrak Compliance/Benchmark scan
failures.

Allows users to automate enabling and disabling Zscaler
policies based on CimTrak’s detection of integrity
violations.

Allows users to monitor, baseline, alert, and roll back ZIA
configuration changes.

Allows users to automate isolating systems via Zscaler
Device Postures based on CimTrak Compliance/
Benchmark scan failures.

Allows users to automate isolating systems via Zscaler
Device Postures based on CimTrak’s detection of integrity
violations.

License Considerations
Monitoring the integrity of ZPA
requires a separate license.

Based on the number of
endpoints under management.

Based on the number of
endpoints under management.

Monitoring the integrity of ZIA
requires a separate license.

Based on the number of
endpoints under management.

Based on the number of
endpoints under management.

©2024 Zscaler, Inc. All rights reserved.
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Prerequisites

The following sections list the prerequisites for the Zscaler and Cimcor integration.

CimTrak Prerequisites

To integrate CimTrak with Zscaler, make sure the following prerequisites are met:

CimTrak Repository v4.1.42 or later installed
CimTrak AppServer v4.1.42 or later installed
CimTrak Collector v4.1.42 or later installed
CimTrak Agent v4.1.42 or later installed
CimTrak Administrator Web Console access

CimTrak Server needs Internet access or a valid route to ZIA or ZPA services

ZPA Prerequisites

To integrate ZPA with CimTrak, make sure the following prerequisites are met:

ZPA Endpoint URL
ZPA Customer ID
ZPA Client ID

ZPA Client Secret

Finding ZPA Endpoint URL
To find the ZPA endpoint URL:

1. Login to the ZPA Admin Portal.
2. Take note of the URL used to login.

= admin.private.zscaler.com/#dashboard/appsDashboard

Applications

‘"

b,

Zscaler Private Access

Q. Search Menu Recent Applications Accessed @

Figure 1. ZPA Admin Portal

Use this URL, but point it to the APl subdomain. For example:

https://config.private.zscaler.com

©2024 Zscaler, Inc. All rights reserved.
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Finding ZPA Customer ID
To find the ZPA customer ID:

1. Login to the ZPA Admin Portal and go to Configuration & Control > Administration Control > Company. The
Company Profile window is displayed.

Applications Users

Recent Applications Acce

Dashboard 6

Insights

Analytics

Authentication

Tl Recent Applications !

Resource Management

Policy

10.0.0.15:11001

Configuration & Control =

Administration Control > Administrators
Public API Roles

Private Infrastructure Audit Logs
Browser Isolation > Company
Certificate Management > Client Sessions
Security > Integrations

Notification Managem... » Executive Insights App Access

Figure 2. Company

©2024 Zscaler, Inc. All rights reserved. 13
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2. In the Company window, find the ZPA Tenant ID. Copy the ZPA Tenant ID.

Company

Loga

& CIMCOR

Name

CimTrak

ZPA tenant ID

Figure 3. ZPA Tenant ID

Generating ZPA Client ID / Client Secret

To learn more about generating a API Client ID and Client Secret, see About AP| Keys (government agencies, see About
API Keys).

Z|A Prerequisites
To integrate ZIA with CimTrak, you must gather the following:

ZIA Endpoint URL

ZIA Administrator Username
ZIA Administrator Password
ZIA APl Key

©2024 Zscaler, Inc. All rights reserved. 14
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Finding ZIA Endpoint URL
To find the ZIA endpoint URL:

1. Login to the ZIA Admin Portal.
2. View the URL you used to login.

=2 admin.zscalertwo.net/#dashboard/1

Web Overview

Figure 4. ZIA Admin Portal URL
Use the ZIA Admin Portal URL, but point to the API subdomain. For example:
https://zsapi.zscalertwo.net

Username/Password

Use an Administrator user’s credentials.
Generating APl Key
To generate an APl key from the ZIA Admin Portal:

1. Go to Administration > Cloud Service APl Security.
2. Click Add API Key.

Cloud Service AP Security

Cloud Service APl Key  OAuth 2.0 Authorization Servers ™Y Sandbox AP Token

Thag et URL for woie A5 in riapel P aber thaes. rst T apdiv 1

*

ey

Ha. Wy Last Modified By Last Mocified On

1 o — A —— Detober 16, 2023 DA AM P

Figure 5. Cloud Service API Security

Creating a Role

Use an Administrator user’s credentials. To create a role:

1. Go to Administration > Role Management.
2. Click Add API Role. The Add API Role window is displayed.

Role Management "™
i Add Admanistrator R, © Add Partrgr Adimind., © Add AP Role

Figure 6. Role Management

©2024 Zscaler, Inc. All rights reserved. 15
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3. Create the API Role by configuring the fields as shown in the image.

Add AP Fiobe »

Hame

Accuss Adeiniplrators ATCess

Advanced Settings ata Loss Provention
~ @

Sacuity

i
.
i
.

Firawall, DNAT, DNS & 05

B
&

Access Control (Web and Mobile) Traffic Forwarding
[+l y and R W, i ] Locat
= st Bl oot
[«] 10 Ex [l

=

Austhentication Configuration

~

Cancel

E ‘l

Figure 7. Add APl Role

©2024 Zscaler, Inc. All rights reserved. 16
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Creating an APl User

To create an APl user:

1. Go to Administration > Administrator Management.
2. Click Add Administrator and assign the created Role.
3. Enter the Login ID and Password.
4

Click Save.
Add Administrator X
Login 10
w

Email MName
Raole Status

! w e
Scope Executive Insights App Access

Onganization w m

Comments
Security Updates Service Updates
.
Product Updates
Passward Confirm Password

Figure 8. Add Administrator

©2024 Zscaler, Inc. All rights reserved. 17
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Configuring ZPA and CimTrak

This section of the deployment guide helps you configure CimTrak to integrate with Zscaler and deploy the monitoring
capabilities or triggers to automate Zscaler policies.

ZPA Integrity Monitoring

CimTrak CimTrak
User Provides CimTrak Checks ZF.'A .Prowde§
ZPA Tenet . Configuration Side-By-Side
A Baselines ZPA /
Cred.entlals to Configuration to l.{ser Comparison to
CimTrak Specified see EXACT
Interval Change
ZPA Integrity Trigger
User
Integrates
User Provides User Creates with a CimTrak §
ZPA Tenet Integrity Policy  ZPA Policy Enables ZPA Damagol
Credentials to for a System in of Choice Policy ¢
CimTrak CimTrak (Isolation/ Automatically

Access/Client
Forwarding)

ZPA Compliance Trigger

User
Integrates
User Provides Léi::c:i::: with a CimTrak
ZPA Tenant 13 ZPA Policy Enables ZPA
A Policy for a A -
Credentials to e in of Choice Policy
CimTrak ys (Isolation/ Automatically
CimTrak

Access/Client
Forwarding)

Figure 9. ZPA and CimTrak monitoring flow

Monitoring ZPA

To set up monitoring ZPA for configuration changes, review the following sections.

Log In to Your CimTrak Console

Go to your CimTrak Web Console in your environment and log in as a CimTrak Administrator. Refer to the following for
example links:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

Figure 10. CimTrak log in

©2024 Zscaler, Inc. All rights reserved. 18
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Creating CimTrak Integrity Policy
After logging in to the dashboard:

1. Right-click the CimTrak Repository in the Tree View.

2. Go to New > Device and Policy.

@ciMmTRAK

G "' ;3 o ll Dazhboard & Repository Info

» @ CimTrak Repository
New = Alda . ck

Change View > Devicea,
Device and Palic)

Lock All._. {':]

Unlock AN 1ange Stream (24hrs)
Force Sync On Al

Cancel All Locks
Reports.

Report Schedule
Uptoad App

Bulk Operations =
Parmissions..

Email
Maintanance =
Propartias. 20.0

Figure 11. Device and Policy

3. Inthe New Device and Policy window, select the Integrity Monitoring (Agentless) option. The Plugin Properties
window is displayed.

New Device and Policy

Create an Agentless Integrity Monitoring Device and Policy
This option dees not require any CimTrak components installed on
the target host. Instead, it relies on a CimTrak Coliector on your
local network to menitor objects such as network devices, switches,
routers, ESXI hosts, cloud infrastructures, Docker hosts, and
Kubernetes hosts via a CimTrak collector.

Create a Compliance Target and Policy
Choose this option if you wish to configure SCAP content

ﬂ (benchmarks) to run either Agentless or on an installed CimTrak
Compliance Agent

Figure 12. New Device and Policy

©2024 Zscaler, Inc. All rights reserved. 19
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4. In the Plugin Properties window:
a. For Device Type, select Zscaler.
b. For Zscaler Product, select ZPA.

Enter the ZPA Endpoint/Customer ID/Client ID/Client Secret previously gathered.

a o

Choose your Output Format (Zscaler recommends Properties Format).

e. Click OK.

Plugin Properties

Device Type Zscaler w
h
Zscaler
Zscaler Product ZPA w
ZPA Endpaoint h'.'.ps:-'-'¢cnr|g.prwa'.e.zs:aler.ca-h

ZPA Customer 1D NG

ZPA Chent ID

ZPA Chent Secret

Custput Format Properties Format (Easler to Read & Compare) b

Import Network Device CSV m
Figure 13. Plugin Properties

f. Click the Arrow next to /DeviceRoot. This shows you what is available to monitor. Zscaler recommends that you
select the top checkbox next to /DeviceRoot to monitor all ZPA configurations.

g. Deselect the configurations you want to exclude.

&

2w
e
™
-
-
P
™

o™

-
o™
-
-1
o™
-
™

-1
vBe
-
LT
vBe
‘R
B womsra m s g

wieras prrstany

Figure 14. Policy Properties
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After selecting the checkbox, configure the Watch Properties. CimTrak recommends choosing Log mode.

6. Change the Poll Detection (interval) to have CimTrak check for an interval of your choice for Zscaler. The default is
every two hours (02 hours and 00 minutes).

7. Leave all other default settings as they are not relevant for this integration.
8. Click OK.

When a change scours Some safteane, buch o4 Backup villiies or vine. detecilon softmare, modify various file
attributes, which will sigeal an ntrusson 1o Cim Trak
Updsts Bassing gt B hive Flag igreare Read-only Flag
Reitars From Repestary fgreore SACL Kgreaes DACL
Nty Onby IGFoTe Cwi SAEUrty igrsrs Oroup Security
4
Cusiom igroms Aemate Stream Data ignare File Dates
Asthoritatve Copy Event Datection Method
Podl inservad (Howrs and M)
B Store suthoritative copy of 3l files i the CimTrak Repatitory. This will sliow CimTrak Basl-bna Detecton

16 arszor fles Back 10 Dy original s12te e i
Cant Stare authortative Sopy Pall 31 Spacific Timd (Latal Tits o b ’
Agent)

Poll i Specific Tame (UTC Time|

Sters Changes Okt Fils Comparisan Methad

Stoee a copy of addedichanged Log Reads SHAZSE -

ey ignore Rwad Directoces

Suppress Sync Start B Syne

Compats Mariages
Auts Evcluse
At wschuds P IS Rave ERargid [ B0 mineA.
Symibolbe Links
Follow Symibolic Links Limved Depth

# Unlimited Depth

[l n

Figure 15. Watch Properties

Q. Enter a Device Name (e.g., Zscaler ZPA).

Policy Properties

B Policy i Attributes 28 Integrations

J
7]

Device Name Zscaler ZPA Device IP | [F of Virtu

at]

Add Watch By Path  Add Directory Exclude By Path  Add File Exclude By Path

» M m /DeviceRoot

Figure 16. Device Name

10. Click OK.

©2024 Zscaler, Inc. All rights reserved. 21
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Enabling CimTrak Integrity Policy

After the policy is created, it is not yet being monitored. To enable policy monitoring intervals:

1. Right-click the policy name and select Lock and Digitally Sign. Monitoring starts by taking an initial baseline and
then reports on any deviations since this baseline.

S s

P
@ - @ Monitor Info

<@ Repository
P % Network Devices frem
* % Okta Products P /DeviceR
» ¥ Qaesxi7
* ¥ Systems

4 W Zscaler Products
» ¥ Zscaler: Product ZIA
4 ¥ zscaler Product ZPA

- Policy

Lock and Digitally Sign

b

Save to Template..
Reports.

Report Schedule
Rename...

Delete
Permissions.
Email...

Froperties
Figure 17. Repository
This process can take some time, and you can see the progress in the Status Window.

3CIMTR.&K ¥ «

4 " = . = v o

M EETE

@

Figure 18. Status window
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2. Afteritis complete, the policy changes from a red Unlock icon to a blue Lock icon. The policy continues to check
on your specified interval. You see the Sync Start message in the Event Log.

.BCIMTRAK

Figure 19. Event Log
Reviewing the Change Log
After CimTrak starts detecting changes, it is reported in the Change Log.

In the following images, you can see the time CimTrak detected the change, and the absolute path that indicates what
changed.

These are the same categories of ZPA configurations you saw when creating the integrity policy initially.

CIMTRAK

:: * € Mondar Info '“' Evént Log = Change Log & Pending Operabons e Gineralon P Ahom:

<@ Repository

b ¥ Network Devices Filter: Last 90 days -
* % Dikta Products
r ¥
< QAESNT Dwvag a column header here and drop i to group by that column
P W Systems <
| 1
4 W Feralar Products Severity Detection Date/Time Absolute path Event
» ¥ Zscaler Product Z1A Waming 62572024 14:10:00 DevceRootServer Group ConrollenServer Group Fike Modified
« W zecaler Product ZPA
3 Waming  GR252024 14.06:08 DeviceRoot'App Connector ControlleriConnector File Modified
= T Pokoy
ming GRE2024 1408 54 DeviceRootSegment Group ControllerSegment Group File Modfied

Warming G200 1408 53 DewvsceRoot/Apphcation Controllen Appiacation

Figure 20. Policy Change Log
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You can right-click an event and click Compare Against Previous State On Agent to see a side-by-side comparison to see
exactly what has changed.

+ @ Reposiory
P Network Devices
Qita Products
QAESNT
Systems
Zscaler Producis
v ¥ Fecater Product 21
" ! Tecaler Product 254
& D pocy

¢ ¢y

Figure 21. Compare Against Previous State On Agent

CIMTRAK

Filltar

Savariny
Warming

Waming
Waireng
Waimning
Wairing
Waming
Waireng
Wameng
Wairng

Waming

-
Dwtwction DatalTirss
B2SR024 175800

BESR004 155303
BZS2024 1410100
B52004 14:00:09
BIZ52024 140854
BRGR004 1408 53
BRS2024 135756
BIEI2024 115756
BIS2024 09.57 56

BISR04 07 57 55

drop it ko group

Absalute path
DenceRoctApp Connecior ControllenConnecion

MewnceRoodApp Connecior Controllen'Connecion

DeveaRoalSares Giol

oup Controller’Server Grous

-]
DrwceRoctApp Connecior Controllen' Connacton
DR oot/Segment Group ContrcllenSegment Group
DirnceRoolApplication ConlrollssAppla abon
MDennteRoApp Conmetol Contrallen Connectcr
MraceRoodApp Connecior ControllenConnecton
MR ooApE Connectol Contrallen Connectcd

MewnceRoodApp Connecior Controllen Connecior

The following is the side-by-side comparison window.

FERRREAERARI RN OROREY

¢ Basehne

BacHi
Evant Caorrection
File Moddsed Basebne Updated
File: Mcedidiesd Baseline Updated
il Mediesd Basahne Upaated
File: Mcedidied Basehne Updated
Share

Demote From Authoniatee Baseline

Compare Againsi Curent State On Agent \‘j
Compare To Cither Gensratan

Wit File
Doweninad File

Figure 22. Compare Against Previous State

©2024 Zscaler, Inc. All rights reserved. 24



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

ZPA Integrity Triggers

The following sections detail how to configure ZPA integrity triggers.

Log In to Your CimTrak Console

Go to your CimTrak Web Console in your environment and log in as a CimTrak Administrator. For example:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

aase Logim

Figure 23. CimTrak Admin

Integrating Zscaler Tenant

To integrate the Zscaler tenant:

1. Right-click Repository in the Tree View on the left.

2. Select Properties.

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

& A Ll Dashboard

<@ Repository

b % Network New > +
' 9 OktaPrc Change View >
» ¥ QAESX  LockAll.

4 W systems  Unlock Al Agent Opel
Force Sync On All

<« 1 Amat
ar Cancel All Locks
a® Reports...
|
a & Report Schedule
Upload App...
P Pl PP
Bulk Operations >
Permissions...
Email...

Maintenance >

o] o | Crangest
@

150
} % Zscaler Products |
100

Figure 24. Properties
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3. Click the Integrations tab.

- Mg T bhan B i i Ry O P

A s e e Paiim Conpiny Waws P ASIAE  Fmall it i
i m

[ o= |
Figure 25. Integrations
4. Enter your ZPA Credentials:
Endpoint: the endpoint URL.
Client Id: the ZPA client ID.
API Key: the ZPA API key.
Customer Id: the ZPA customer ID.
CimTrak Repository Properties
= - &P 53 ] B & Effect
8, Installation Ke o #, Comy o Integraticns £ Suppon
~Zacaler:
Endpaint hitps:/iconfig private zscaler.com
ol e TR R R B TR
APl Ky
Curiomar e

Figure 26. ZPA credentials
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Creating CimTrak Integrity Policy

To create a CimTrak integrity policy:

1. Inthe left-side Tree View, find the system in question for which you want to create a policy.

2. Right-click the <agent name>, and select New > Policy.

CIMTRAK

INTEGRITY. TRUST & RESILIENCY

& *

« @ Repository
* % Network Devices
» ¥ Okta Products
» ¥ oaesxi7

¥ gystems

“ & Alma9 - Prod Server

8

a% Compliance

a® Access Polic

ad Client Fowar

w @ Isolation Pol
+ L wint1-147

a% Compliance

& @ pccess Polic

@ Info &3 Event Log = Change Log

Operating System: AlmaLinux 9.3 (Shamrock |

AgentIP: 127.0.01

Agent UUID: 2d7d65d8-a943-434b-82eb-becebt

New > Po " i
pockal 711072024 10:56:24 (5 hours 2
Unlock All

Force Sync On Al »d Time: 7/10/2024 15:57:10 (2

Cancel All Locks
Save FIM Policies to Template..
Reports...

& D ClentForws  Report Schedule

- & Isolation Pol Tags Jnents:
» % Zscaler Products betame
Delete
Permissions. nt
Email...

Maintenance >
Properties

Figure 27. CimTrak policy

3. Select Integrity Monitoring (Agent Based).

New Policy

Create an Agent based Integrity Monitoring Policy

Choose this option to monitor things such as the registry, file
system, and installed software. This is a freeform policy. Choose
this option if you know which components and paths you wish to

momnitor.

Create an Agent based Integrity Menitoring or Compliance
Policy via Template

This allows you to create predetermined polices from a premade
template. These templates can be created by the user or may have

been provided with the inital install of CimTrak

Create/Edit a Compliance Policy

Choose this option if you wish to configure SCAP content
{benchmarks) to run either agentless or on an installed CimTrak
Agent. If this node has a CimTrak Agent installed with the

compliance compeonent, the scan will be performed from the locally

installed agent, otherwise, it will be run from the CimTrak Collector

Figure 28. New Policy
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4. Select the folder or object that you want to monitor. In this case, it is a folder on a Linux system.

Policy Properties

@ Policy

Policy Name

Bulk Watch/Exclude By Path ~ Add Watch By Path  Add Directory Exclude By Path  Add File Exclude By Path

4 OGa
O ars

¢ Ol Backup
v Ol bin
Ol boot

37— DEMO
- dev

v
3
v
v
N
v
N
N
* O mnt
v
N
v
N
N
v
v
N
v

v O ysr
v O var

O iPort.Manitar
Il Watched in this group

Watched elsewhere

Figure 29. Policy Properties

5. In the window that displays, select the monitoring options you would like to use. For this example, Log mode is
selected and everything else remains as default.

6. Click OK.

Watch Properties.

Wean 3 changs acours Some poftware, BUCh 33 Baskup VEINER oF vings SeSecton toftware, moody vanious il
anribaes. which will Bignal Bn inrusion 1 Cim Tras
& Leg
Updaw Baseisne ignacs Arenave Flag ipnore Aasd.anly Fiag
B stoen from Repazary Ignace SACL ignore DACL
Moty Only Ignare Canar Sacurity ignore Group Security |
Crantem Igrace Altsrnate Stream Dats ignore Fils Dates
Authsritasie Copy Evert Datmetion Wathad
Stodw sutheritative edgy of all Fles i the CimTrak Repeaitery. This will allow Cim Trak ® Real-tive Datection

10 revtoee files Back 10 their origenal state Pgdl Oetecton [inderval]

¥ Dot Stare sutheritative sopy Pedl 3t Specific Time [Lecal Time on
Agent)

Padl at Specific Time [UTC Tima)

S1ord CRIAGES anar Fiie Camparistn Mamod
SI0 3 Copy Of edENInged L Reads SHAZH -
e

igrore Read Dirsciones

Suppress Syne Stan & Syne

Compiete Mrriages

Aurin Excluce

Aty Enhad NS That have Changed nmes i B0 minuses.

Symbadic Links

Foliom Symiols Links Liméind Depih

® Uniivites Daptn

Figure 30. Watch Properties
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7. Enter a name for the Policy Name.

8. Do not click OK and proceed to Configuring Zscaler Integration, next.

Policy Properties

B8 Policy i Attributes 5 Integrations

Policy Name

Bulk Watch/Exclude By Path  Add Watch By Path  Add Directory Exclude By Path  Add File Exclude By Path

* [0l SRecycle.Bin

» [0 swinREAgent
» [0l Application-Files
» O CIMCOR FILES
» Owd cimTrak

« Bl m DEMO Policies

* D m TestFolder

4 d

O Documents and Settings
* O Program Files
* O Program Files (x86)
== ProgramDala
O RansomWare-Example
O Recovery
reports
O system Volume Information
O Tools

O
I

O Tuning .
B Watched in this group

Watched elsewhere

Figure 31. Policy Name

Configuring Zscaler Integration

To configure the Zscaler integration:

1. Click the Integrations tab.

o BipichBachcis by Pl k] Pt By Bl Achi Dommciony iy P A e By el - Cupn e v Ersate B e s Fiat Corrmetin s ER—

Figure 32. Integrations tab
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2. Choose the ZPA Policy type to integrate:
Access Policy. See Integrating with Access Policies.
Client Forwarding Policy. See Integrating with Client Forwarding Policies.

Isolation Policy. See Integrating with Isolation Policies.

Brabard  Piday Ry Bt e B Bt s ] Sir s ped Ll

Figure 33. Policy Types

Integrating with Access Policies

To integrate access policies:

1. Select ZPA - Access and click Add.

New policy: ZPA - Access hd m

Figure 34. New Policy
2. A window displays for you to configure how you want this integration to interact with your policy. It is a logic
statement that you can configure and change with a drop-down menu, as follows:

If an <INTEGRITY TRIGGER> occurs, then trigger Zscaler rule <ZSCALER ACCESS POLICY> in <MODE> mode,
otherwise leave the policy in <MODE> mode.

Ha w oo, Tuen irgger Eucaiss rols 2 v i w mde OINTEES v e gy o e

Figure 35. Access Integrity Trigger
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The following sections define the parameters:

INTEGRITY TRIGGERS: The CimTrak Integrity options to trigger the policy you configure.
- Change: If any change that deviates the baseline.
- Denied List Item Found: If any change was a matching hash in the CimTrak Deny List (denylist).
-Not in allowed list: If any change was NOT a matching hash in the CimTrak Allow List (allowlist).

ZSCALER ACCESS POLICY: This drop-down menu populates the available Access Policy found in your ZPA
environment:

- Access Policy 1
- Access Policy 2
- Access Policy N

Access Policy | Timeout Policy  Client Forwarding Policy  Isolation Policy  Pr

ZIscaler Private Acoess

b
Dashboard
" Rule Order Name
Insights
Analytics > 1 PEP-PD¥ C2C
Authentication »
y 2 Maschineg Tunngl
Resource Managemen. »
Palicy - > 3 SEIM Splunk
Access Policy
y 4 SEIM Elastic
Timeout Policy
Client Forwarding Policy > 5 VPNKiller-intemal-Websites
Isolation Policy
» & KLAS = ZT st the Tactical
Security Policy
r ROP SSH via ZCC
Privileged Policy >} 1 D55 =
Redicection Pollcy » Privilege Remote Access
% Configuration & Control »
4 > 2 py of VPNKiler-Ir ek
El Client Connector (4
& Account L4 » 1 EviAccessPolicy

H Tools »

Figure 36. Access Policy
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MODE: The Access Policy Rule Actions:
- Allow Access
- Require Approval

- Block Access

Edit Access Policy X

Namie

PEP-PDP C2C

Duscription

Varonis Comply to Connect
ACTION
Rule Action App Connector Selection Method
Alow ACCess © Block Access Require Approval b o -
pp Connector groups or Serv
App Connector Groups Serder Groups
SkyTap Ent - Skytap Server Group -

Message to User

Hello User You are baing blocked from Acces

ta because of unexplained Activity, Please call halpdesk! 1800 HelpDesk

Client Connector Posture Profiles €@

Save Qe

Figure 37. Rule Actions

3. Click Save. The final logic statement created for the policy trigger is displayed.

Endorcement Tarreed
Enabled  Poboy type Erloroement Jummany Fore

] ZPA - Accewm Fa Changs cooun, Fan bgges Zucaier rus PEP-POF CFC n Black mods, Shereiss e P g Al mida n

Mewpibty | TP Accs ﬂ

Figure 38. Final logic statement
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4. Click OK to save the policy.

Erforcerman Curvers

& I - Moy 1 C bt cocury, San bgger Dicaier rus FIP-POP CIC o Bloch mods offarens save e poboy i Alow mods m =

Figure 39. Save the policy

5. Find your new policy under the Agent. It was created with a red Unlocked icon because it is disabled. To enable it,
right-click and select Lock and Digitally Sign.

& 4 € Monitor Info

« [@ Repository
¥ % Network Devices tem
» % Okta Products » /DEMO (4)
» ¥ QAESXi7
4 % Systems
4 L AIma9 - Prod Server
w Compliance Policy
- & Access Policy
- & Client Fowarding Polic
- @ Critical Directory
w @ isolation Policy Lock and Digitally Sign... 5

4 1 \Win11.147
Figure 40. Lock and Digitally Sign

It takes a baseline of the objects you configured to monitor to get the current state. When complete, it has a blue Locked
icon, which means it is enabled.
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Testing the Integration

Now it is time to test your rules.

In the following example, a policy was set up to monitor the directory /DEMO. The trigger is CHANGE, which enables the
Access Policy that is in ALLOW mode.

1. Check the directory. The following shows the current state of the directory.

[root@alma%-50 DEMOJ# pwd
JDEMO

[root@almag9-50 DEMO]# 1ls -1
total 848
-rw-r—r—. 1 root root 3 . B 15:57 filel
-rw-r—r—. 1 root root B . ¢ : filez
-rw-r—r—. 1 root root ) 1
-rw-r—r—. 1 root root 635 . )

-rw-r—r—. 1 root root 12 . B ' nginx.cont
-rwxr-xr-x. 1 root root 859488

drwxr-xr-x. root root

[root@alma9-50 DEMO]# Ji

Figure 41. Current directory state

2. If afile is added that does not match any hash in the CimTrak Authoritative Baseline, it triggers the access policy.

[root@almag-56 DEMO]# touch nefarious-file
@almag9-50 DEMOJ# 1s -1

total 848
-rw-r—r—.
-rw-r—r—.
-rw-r—r—.
-rw-r—r—.
-rw-r—r—.
-rw-r—r—.
-FWHEr-Xr-X. root root
drwxr-xr-x. root root
[root@almag-568 DEMO]# ]

Ln

root root
root root
root root
root root
root root
root root

37 filel
filez

nefarious-file
nginx.cont

e
el el e Ll el el o

Figure 42. Triggered Access Policy
3. From the CimTrak Web Console, go to the Policy Event Log.

JCIMTRAK .

e e,

Figure 43. Policy Event Log
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4. In the Event Log, you can see that the new file was detected with other forensic details. You can also see one
second later the access policy was triggered.

[irag 8 cobarn Readier been and drop # 19 group by Tiad cokemn
-
Sevesity  Detection Date/Time  Event Absolute path Modified By Process Process 1D
riae) |Fo Ena & £ . ’ _—
" ™
!
rier,

Figure 44. Triggered Access Policy

5. Go to ZPA Edit Access Policy. The Access Policy is in Block Access mode.

Edit Access Policy X

Hamix

Ruly Action App Conngcior Spigction Mathod

LIRSt O Block Access Require Approval

App Connecior Groups Sarver Groups

Message 1o Usas

Hedo User ¥ou are being biocked from Accessing DOD Data because of unexplained Acthvity. Please call helpdesk! 1800 HelpDesk

Client Connector Posture Prafies @

Cancel
T —
Figure 45. Edit Access Policy
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Resetting the Integration

While you can change the Rule Action status within ZPA, there is also an option to do it from the CimTrak Web Console:
1. Right-click Repository, then select Properties.

@ - & Monitor Info

« @ Repository
b % Network Devices frem
¥ % Okta Products > /DEMO (4)
r ¥ anesxi7
4 % Systems
+ L Amag - Prod Server
W Compliance Policy
W@ Access Paolicy
w Client Fowarding Polic
wth Critical Directory

w® Isolation Policy
v L Win11-147 Unlock and Allow Changes

Fi S
¥ % Zscaler Products e

Save to Template..
Reports...
Report Schedule

Permissions..

Email .

s
Figure 46. Policy Properties

2. Click the Integrations tabs. You can see the current ZPA policy status.

Policy Properties

& Policy iAttributes & Effective Credentials £ Integrations
Policy Name | Critical Directory [MEIELTTs

Bulk Watch/Exclude By Path ~ Add Watch By Path  Add Directory Exclude By Path ~ Adc

» Bl

L rPort-Monitor
» L /1System Groups
r LIl /rSystem Users

Figure 47. CimTrak Integrations

3. Click Reset to undo the action.

Erazwa  Peboy e Errorcmans Somm iy Ertorcamann Surear Sum

a P o & g s, s Wi Bt st PO 5 1 ek et affermins i A . i | 3 m
Bl

Figure 48. Reset button
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Integrating with Client Forwarding Policies

To integrate with client forwarding policies:

1.

Select ZPA - Client Forwarding and click Add.

New policy: ZPA - Client Forwarding v

Figure 49. ZPA Client Forwarding

In the Client Forwarding Policy window, configure how you want this integration to interact with your policy.

= Dover.wn wigger P rals o = : = msta oswrens v S posoy = o msse

=
Figure 50. Client Forwarding Policy

This is a logic statement that you can configure and change with a drop-down menu, as follows:

If an <INTEGRITY TRIGGER> occurs, then trigger Zscaler rule <ZSCALER CLIENT FORWARDING POLICY> in <MODE>
mode, otherwise leave the policy in <MODE> mode.

These variables are defined as follows:

INTEGRITY TRIGGERS: The CimTrak Integrity options to trigger the policy you configure.
- Change: If any change that deviates the baseline.
- Denied List Item Found: If any change was a matching hash in the CimTrak Deny List (denylist).
-Not in allowed list: If any change was NOT a matching hash in the CimTrak Allow List (allowlist).

ZSCALER CLIENT FORWARDING POLICY: This drop-down menu populates the available Access Policy found in
your ZPA environment:

- Client Forwarding Policy 1
- Client Forwarding Policy 2
- Client Forwarding Policy N

Figure 51. ZPA Client Forwarding Policy
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MODE: The Client Forwarding Policy Rule Actions:
- Forward to ZPA
- Only Forward Allowed Applications
- Bypass ZPA

Edit Client Forwarding Policy

Namea

Qutage-BackupServer-Reroute

Description

test

ACTION

Rule Action

Forward to ZPA Only Forward Allowed Applications © Bypass ZPA

CRITERIA
O A
Save [QEeERTE]
Figure 52. Edit Client Forwarding Policy
3. Click Save. The final logic statement is created for the policy trigger.
B TRy S o T s o OB e s o o o 18 TP oce - S ——— n u

Figure 53. Logic statement
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4. Click OK to save the policy.

Erbrrgmme Syrreed Tarie

™ . - - Boais badanian Yghnd o st Pl Bul hpasas Do Wi u n
e P ety Bymene

Ham patcy u

Figure 54. Save the Policy

5. Find your new policy under the Agent. It was created with a red Unlocked icon. This means it is disabled. To turn it
on, right-click and select Lock and Digitally Sign.

vl " @ Monitor Info g

+ @ Repository
» % Network Devices
* % Okta Products > /DEMO (4)
» ¥ qaesxi7

Item

4 W Systems
« 1 Alma8 - Prod Server
ot Compliance Policy
w @ Access Policy
w @ Client Fowarding Polic

m & Critical Directory

w @ Isolation Policy Lock and Digitally Sign...ﬁﬂr,] I
¥ & Wini1-147

» % Zscaler Products

Save to Template...
Reports...
Report Schedule

Rename...
Delete
Permissions...

Email...

Properties...

Figure 55. Lock and Digitally Sign

It takes a baseline of the objects you configured to monitor to get the current state. After it is enabled, it has a blue
Locked icon.
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Testing the Integration

Now you can test the integration rules. In the following example, a policy was set up to monitor the directory /DEMO. The
trigger is CHANGE, which enables the Client Forwarding Policy (currently in Bypass ZPA mode).

This is the current state of the directory:

[root@alma9-560 DEMO]# pwd
JDEMO

[root@almag-50 DEMO]# 1ls -1
total 848
-rwW-r—r-—.
-rw-r—r—.
-rw-r—r—.,
-rw-r—r—.,
-rW-r—r-—.
-FWXF-XF-X.
drwxr-xr-x. 5 root root 83
[root@almag-50 DEMO]# Hi

root root A . 5:57 filel

root root 3 . 5:57 file2

root root 3 . file3

rooct root 85 . 5 fstab

root root 1: - nginx.cont
root root 859488

L

Figure 56. Current directory
When you add a new file that does not match any hash in the CimTrak Authoritative Baseline, it triggers the Access Policy.

[root@almag-50 DEMO]# touch nefarious
[root@almag9-58 DEMO]# 1s -1

total 848
-rwW-r—r—.
T e
T e
-rwW-r—r—.
-rw-r—r—.

root root 3 Jul 18 15:57 filel

root root 3 Jul 18 7 file2

root root 3 Jul 18 15:57 file3

root root 505 Jul 16 :56 fstab

root root 3 Jul 18 :58 nefariwous-file
-TW-r—r—. root root Z2 Jul 18 15: nginx.cont
-MWXEM-Xr-X. root root 8594 Jul 18 et s55h
drwxr-xr-x. root root 3 Jul 18 .
[root@almag-56 DEMO]# |

AL b s s s

Figure 57. Access policy triggered

In the CimTrak Web Console, go to the Policy Event Log. In the Event Log, you can see that the new file was detected with
other forensic details

DCIMTRAK

*hwmd 4

Figure 58. Policy Event Log
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You can also see 1second later the Access Policy in question was triggered.

Sevwnty  Dwiscoos Do Time  Event

Figure 59. Access policy triggered

The ZPA Client Forwarding Policy is in Forward to ZPA mode.

Edit Client Forwarding Policy

Mamig

Outage-BackupServer-Reroute

A gl paTh Modified Dy Proosss Procets 10

Description

test

Rule Action

© Forward to ZPA Only Forward Allowed Applications Bypass ZPA

CRITERIA

Figure 60. Edit Client Forwarding Policy
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Resetting the Integration

While you can change the Rule Action status in ZPA, there is also an option to do it from the CimTrak Web Console.

1. Right-click Repository, then select Properties.

% - © Monitor Info

4 |8 Repository
¥ % Network Devices
¥ ¥ Okia Products P> /DEMO (4)
» ¥ oaesxi7

4 % Systems

4

Item

« Alma8 - Prod Server
w Compliance Policy
w @ Access Policy
w @ Client Fowarding Polic
w @ Critical Directory

w @ Isolation Policy
YL Win11-147 Unlock and Allow Changes

Force Sync
b % Zscaler Products Y

Save to Template...
Reports...
Report Schedule

Permissions...

Email...
"

Figure 61. Properties

2. Click the Integrations tab.

Policy Properties

B Policy i Attributes & Effective Credentials £ Integrations

Policy Name  Critical Directory LT RIS

Bulk Watch/Exclude By Path  Add Watch By Path  Add Directory Exclude By Path ~ Adc

Y

O N

[ //Port-Monitor
¥ LI /System Groups
¥ LI /System Users

Figure 62. Integrations
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You can see the current ZPA Policy status. Click Reset to undo the action.

Policy Properties

@

bolicy  iAmibutes & Effeetive Cr

Enabled  Policy type Enforcement Summary Enforcement Current State

ZPA - Client Forwarding If 2 Change occurs, then trigger Zscaler rule Outage-BackupServer-Rerouts in Forward to ZPA mode, otherwise leave the policy in Bypass ZPA Forward to ZPA m -D
mode

Figure 63. Reset the action

Integrating with Isolation Policies

To integrate with isolation policies:

1. Select ZPA-Isolation and click Add.

New policy: ZPA - Isolation ~ m

Figure 64. ZPA-Isolation

2. The following dialog displays. Configure how you want this integration to interact with your policy.

LN w D, e TesEe e s v g Trtue st Profls w .

At e B s g -

Figure 65. Isolation policy configuration
This is a logic statement that you can configure and change with a drop-down menu, as follows:

If an <INTEGRITY TRIGGER> occurs, then trigger Zscaler rule <ZSCALER ISOLATION POLICY> using Zscaler Isolation
Profile <ZSCALER ISOLATION PROFILE> in <MODE> mode, otherwise leave the policy in <MODE> mode.
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These variables are defined as follows:

INTEGRITY TRIGGERS. The following are the CimTrak integrity options to trigger the configured policy:
- Change: If any change that deviates the baseline.
- Denied List Item Found: If any change was a matching hash in the CimTrak Deny List (denylist).
-Not in allowed list: If any change was NOT a matching hash in the CimTrak Allow List (allowlist).

ZSCALER ISOLATION POLICY: This drop-down menu populates the available access policy found in your ZPA
environment:

- Isolation Policy 1
- Isolation Policy 2

- Isolation Policy N

.q:.\ Access Policy Timeout Policy  Client Forwarding Policy | Isolation Policy

Zscaler Private Access

> No
Dashboard
= Rule Order Name
Insights
Analytics > 1 rowser Isolation Elastic
Authentication »
> 2 Browser Isolation Splunk

Resource Management #

Policy -
Defauliule

Access Policy

- ame Rule Ac!

Timeout Policy
Chient Forwarding Policy Default_Rule RULE A
Bypass
Isolation Policy Deseription J—

£ = Thi he default Isclation Policy rule
Security Policy his is the default Isclation Policy r

Privileged Policy

Redirection Policy

Figure 66. Isolation Policy
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ZSCALER ISOLATION PROFILE:
- Isolation Profile 1
- Isolation Profile 2
- Isolation Profile N
MODE: This refers to the isolation policy Rule Actions:
- Allow Isolation

- Bypass Isolation

Edit Isolation Policy b 4

Name

Browser Isolation Elastic

Description

Browser Isclation Elastic

ACTION

Rule Actign Isolation Profile

[V PEENE U Bypass Isolation

CRITERIA

Application Segments @

Segment Groups

Client Types

Web Browser -

Figure 67. Rule Actions
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3. After clicking Add, the final logic statement is created for the policy trigger.

Ensiemz  Fosxy repe Erémeramant fammary Erdorcemaers Cumee fone

(-] b i Chang wr g Do e vl B aon bk ey D s Full Booany Cmem - fesirtn s u m
s o s . hpas e

&=
Figure 68. Logic statement
4. Click OK.
L] i «
Ensbied  Frdoy o Ertorinenyr By Erbrrgemges Surrend barte
5 i, . Crusgs 3 - [ SSSSSTRNIIY Fe—— a di Pl Aaaess Dama o inaiens u n

e paiey . n

L

Figure 69. Save the policy
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5. The new policy is under the Agent and is created with a red Unlocked icon. This means it is disabled. To turn it on,
right-click and select Lock and Digitally Sign.

v * O Monitor Info

F |

L3 Repository
Item
¥ % Network Devices

¥ % Okta Products » /DEMO (4)
» ¥ onEsxi7
4 % Systems
4 & Alma9 - Prod Server
R Compliance Policy

b @ Access Policy

A A . .
- Client Fowarding Polic'
d-‘ agm -
= 2 Critical Directory
- & Isolation Policy Lock and Digitally Sign.. J\h
4 1 Win11.147 .

Figure 70. Lock and Digitally Sign

It takes a baseline of the objects you configured to monitor to get to the current state. After that is completed, it has a
blue Locked icon, which means it is enabled.

Testing the Integration

Now you can test your rules. The following example is a policy set up to monitor the directory /DEMO. The trigger is
CHANGE, which enables the Isolation Policy in Bypass Isolation mode.

The following is the current state of the directory:

[root@almad-50 DEMO]# pwd
JSODEMO
[root@almag-50 DEMO]# 1ls -1

root root 3 . 5:57 filel

root root 3 . filez

rooct root 5 . file3

root root 6O5 . : fstah

root root 2. nginx.conf
S rWXr-Xr-X. root root 85 . . sgh
drwxr-xr-x. 5 root root :

[root@almag-56 DEMO]#

-TW-r—r—.
-TW-r—r—,
-TW-r—r—,
-rW-r—r—.
-rW-r—r—.

el e

N

Figure 71. Directory state
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When you add a new file that does not match any hash in the CimTrak Authoritative Baseline, it triggers the Access Policy.

[root@almag9-58 DEMO]# touch nefarious-file
[root@almag-56

total 848
-PW-F—F—.
-FW-F—F—.
-TW-T—r—.
-TW-T—r—.

filel
root root 3 . 5:57 filez
root root ) . 7 file3
root root 6AS . 5:56 fstab
root root 3 . 5: nefarious-file
-TW-F—r—. root root 2 . :26 ngunx.cont
-TWXI-Xr-X. root root 8594 . = ssh
drwxr-xr-x. 5 root root :
[root@almag-560 DEMO]# Ji

-rw-r—r—.

L el

Figure 72. Triggered Access Policy

From the CimTrak Web Console, go to the Policy Event Log.

j} CIMTRAK

Figure 73. CimTrak Web Console

In the Event Log, you can see that the new file was detected with other forensic details. You can also see one second later
the Access Policy in question was triggered.

Severity  Dadsscton DaiwTims  Event Alualube paih Melhsd By  Proces Process 1D

Figure 74. Event Log
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The ZPA Isolation Policy is now in Allow Isolation mode.

Edit Isolation Policy X

MNarme

Browser Isolation Splunk

Dascription

Spdunk Browser Isolation

Rude Action Isolation Profile

el Full Acce et 2

CRITERIA

Application Segments @

Segment Groups

Client Types

m Cancel

Figure 75. ZPA isolation policy in Allow Isolation mode
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Resetting the Integration

While you can change the Rule Action status within ZPA, there is also an option to change it from the CimTrak Web

Console.

1. Right-click Repository, then select Properties.

h S O Monitor Info

4 |8 Repository
¥ % Network Devices ftem
¥ % Okta Products > /DEMO (4)
» ¥ oaEsxi7
“4 % Systems

“ <« Alma9 - Prod Server

@A Compliance Policy

w® Access Policy

C al Client Fowarding Palic

w @ Critical Directory

w® Isolation Policy
» Win11-147 Unlock and Allow Changes

-

Force Sync
¥ % Zscaler Products Y

Save to Template...
Reports. ..
Report Schedule

Permissions...

Email...
"

Figure 76. Properties

2. Click the Integrations tab. You can see the current ZPA Policy status.

Policy Properties

B Policy i Attributes & Effective Credentials & Integrations
Policy Name Critical Directory LT FiTee

Bulk Watch/Exclude By Path  Add Watch By Path  Add Directory Exclude By Path

Y

LI
L' /Port-Monitor
¥ [T /System Groups

¥ [l //System Users

Figure 77. Integrations

Adc

©2024 Zscaler, Inc. All rights reserved.

50



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

3. Click Reset to undo the action.

Ensbing  Polgy type Bt pemprst Bogmmpry. L e ey T

[ -] B ¥ ¥ i Chubg o T ir T g P ” Ao Pl Aoomid Deeed « Mhdlbe Faoy Ty
¥ 7 By o

Figure 78. ZPA Policy Status

ZPA Compliance Triggers

The following sections describe how to configure ZPA compliance triggers.

Log In to Your CimTrak Console

Go to your CimTrak Web Console in your environment and log in as a CimTrak Administrator. For example:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

Figure 79. CimTrak console
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Integrating Zscaler Tenant

To integrate the Zscaler tenant:

1. Right-click Repository, then select Properties.

CIMTRAK

INTEGRITY, TRUST & RESILIENCY
@ * [l Dashboard
« @ Repository
P 9 Network New > + = i
* % OktaPrc Change View >
» ¥ OAESX LockAl.
4 W Systems Unlock All Agem OpEI

4 [ Ama Force Sync OnAll
Qs Cancel All Locks
Q@ Reports...

& 7)) Report Schedule
o ® Upload App...

Bulk Operations =

« 1 winr S
ermissions...
P
Email...
& @
& Maintenance >
el .

e

150
¥ % Zscaler Products |
100

Figure 80. CimTrak properties

2. Click the Integrations tab.

- E i ] 5, i
. a .
- B -
AT s Fort e LT Dinpiny Wame  From Adrees  fmstiimms e Boquon TLE s Rt e g ey e Paiicrn
o E=
e Wt drrw Pt Trigger Larel
Bagars FLA
2 mme ey
it UTPE | Usae L
N o4 vwets T Eamp
Wriss L % P s L Pl AR ey
PPPTRR F —
B Eariate Events kisocate T Tesst Sarl Dvesd Bty By Ohjesl. Pl
Niarioen B Cumtom Ll Fome Sruse,

Figure 81. Integrations tab
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3. Enter your ZPA Credentials:
ZPA Endpoint URL
ZPA Client ID
ZPA API Key
ZPA Customer ID

CimTrak Repository Properties

¥ a i .| = a
8, Installation K a * o aticns 8
~Z3caler:

Endpoint hitps

tps:ficonfig.private.zscaler.com

i el S B B R s R e S

AP Key

Cuttomerid | |

Figure 82. ZPA Credentials

Creating CimTrak Compliance Policy

To create a CimTrak compliance policy:
1. Inthe left-side Tree View, find the system for which you want to create a policy.
2. Right-click <Agent name>, select New and then Policy.

CIMTRAK

RITY, TRUST & RESILIENCY

@ * 0 Info £ Event Log = Change Log

4 @ Repository
Operating System: AlmaLinux 9.3 (Shamrock F

¥ Network Devices
% Okta Preducts
¥ onesxi7

% Systems. Agent UUID: 2d7d65d8-a943-434b-82eb-bcebb

AgentlIP: 127.0.0.1

-

8

4 & Amag - Prod Server
Policy. 0)
WP Access Policy ~ New > 30)

N
w @ Client Fowardii  LockAll.. ,
¥ lock All ¥ 7/10/2024 10:56:24 (a day agc
w @ \solation Palicy  INioc

i Force Sync On All
YL Win11-147 e IJ:II e sed Time: 7/10/2024 15:57:10 (2
ancel oc
* % Zscaler Products

Save FIM Policies to Template.

Reports...

Report Schedule

Tags..

Rename... lonents:
Delete

Permissions

Email... mnt
Maintenance >

Properties.

Figure 83. Policy
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3. Click Compliance Policy.

New Policy

Create an Agent based Integrity Monitoring Policy

@ Chaoose this option to menitor things such as the registry, file
Integrity Monitori
f:::ﬂ B ]ng this option if you know which compeonents and paths you wish to

system, and installed software. This is a freeform policy. Choose

monitor

Create an Agent based Integrity Monitoring er Compliance
. Pelicy via Template
Integrity Monitoring
or
Compliance template. These templates can be created by the user or may have

(Via Template) been provided with the inital install of CimTrak

This allows you to create predetermined polices from a premade

Create/Edit a Compliance Policy

Choose this option if you wish to configure SCAP content

* {benchmarks) to run either ag of on an installed CimTrak
Compliance Agent_ If this node has a CimTrak Agent installed with the

compliance component, the scan will be performed from the locally

installed agent; otherwise, it will be run from the CimTrak Collector.

Figure 84. Compliance

4. Expand the Mappings node.

Agent Properties for Al rod Server
- acw L L
Marma Trp
a
L]
. crae . hueersal bgn -
ul y lerchmar k v
= by Frpmpaceh Vigrpaon 71 farsing Pia-
0 g r weriace B0
) T Cwrcnpmon pruon Prodie
¥ O b Crou Secor Cyterusnaty Pericmarce
* O b Cybemecunty Seiermance Goalu
W
W .
P Addrews 107 Cumrreent Soarmer S - Prod Seve Cwrrerd Copdpntialn Dslad
~Legend: m Cosbgure Soheing
W Ceriho Ly - Updaie At .
Rk —— - S
i+ Pasding Cortlics ¥ T B - Lruk i -
indy (oaplay Appipable Benghmaris B
$can Hiriory Retsreon Doy (0 = Delaul)
L m—r—— H

Figure 85. Mappings node
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5. Select any Compliance Frameworks you are tracking on this system. It automatically chooses the CIS Benchmark
you must run to track that Compliance Framework. You can choose multiple if required.

6. Select the Profile for the benchmark that is applicable for the system (i.e., Workstation/Server/Domain Controller).

Tortirg un

Tee Dwscrigion Wemion Protis

_

® Aadeuan: T 001 | Curent Seasner: S herver | Gurren Cevdustioh

Figure 86. Select Profile

The following image shows the profile type.

& Brofl

Titha Deeneription

Figure 87. Select Profile Type
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7. Select Configure Schedule to determine when you want CimTrak to run the benchmark scans.

Teaung Pus
Tea Daacripticn varuon Protes
® Asaren: 12 Csmpnt Leamnae firn : Cusrmpat Craduntisiy: [t
i
Rired taid ﬂ

Figure 88. Configure Scheduling

The default is Every Day at Midnight Server Time.

Scheduling

o]

® Day per montt

Figure 89. Set schedule
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Configuring Zscaler Integration

To configure Zscaler integration, click the Integrations tab.

B

£ 0

-

-

0w

* O wen Tarding Pias

L=

O st o Cwenpaon Vet Proti

' B st

vO

v O ms

0w

W updrer: VT 000§ Cament Banaar Mo 1 Serves | Camrem Coydarnaly: Dsli

T [ comacions | contposSmeg |
tinky iy Apphcsbie Banchmaris B
B Histary asarmon Days (8 » Dedpir)

Figure 90. Integrations

Integrating with Access Policies

To integrate with access policies:

1. Select ZPA-Access and click Add.

New policy: ZPA - Access e m

Figure 91. Add ZPA Access

2. Configure how you want this integration to interact with your policy.

w GOy T Wgge Tisaler fae

A e ST T ST B £ ORI PR R T

Figure 92. Configure Access Policy

3. Thisis a logic statement that you can configure using a drop-down menu, as follows:

If a <COMPLIANCE TRIGGER> occurs, then trigger Zscaler rule <ZSCALER ACCESS POLICY> in <MODE> mode,
otherwise leave the policy in <MODE> mode.

Automatically reset when above condition is no longer met. This setting disables the ZPA Policy if the system is
in a PASSING state for the configured Compliance Policy.
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These variables are defined as follows:

COMPLIANCE TRIGGERS: There is only one Compliance Trigger:

- Pass threshold not met: This means if the Compliance/Benchmark scores do not meet the configured
threshold in CimTrak, the ZPA Policy triggers. You can configure this threshold in the Repository Properties.
Right-click Repository in the Tree View on the left, then select Properties.

(JcIMTRAK

@ - Ll Dashboard
+ @ Repaository
» ¥ Networl New > + =

» % Oktapr ChangeView >
» ¥ qaps  LockAll

-

4 W gystem Mnlock Al i
+« L ame ForceSync OnAll (
g Cancel All Locks
W
@ @ Reports.
a @ Report Schedule
Upload A
Rk
Ik
b W Zscaler Bulk Operations >
Permissions...
Email...

Maintenance >

Figure 93. Properties

4. Click the Compliance tab.

Loggng Uerasy Sarew o

Figure 94. Compliance tab
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5. Configure what test percentages equate to a PASS value. The default is 100%.

CimTrak Repository Properties

[# Logging = General & Passw E Communication & Effective Cre

& Installation Key 0 OS Specific #, Compliance &5 Integrations & Support

Allow Remote Compliance Sources [ @
Default Collector o0 op v ©
Save ARF (Asset Reporting Format) Results [] @

Keep 4o megabytes of ARF Results.

Benchmark Pass Threshold  4ng % @

Mapping Pass Thresheld  4gp % @

Policy Group Threshold g % 9

Enable Auto-Update For Compliance Content (Mappings/Benchmarks) [ @

Enable Auto-Update of Existing Cempliance Policies (Mappings and Benchmarks) to Mewest Versions Upon Receipt [ @

Figure 95. Repository Properties
ZSCALER ACCESS POLICY: This drop-down menu populates the available Access Policy found in your ZPA
environment:
- Access Policy 1
- Access Policy 2

- Access Policy N

iﬂ. Access Policy | Timeout Policy  Client Forwarding Policy solation Policy  Pr

Zscaler Private Access

> M
Dashboard
. Rule Order Name
Insights
Analytics > PEP-POP C2C
Authentication »
» 2 Maching Tunnel
Resource Managemen. »
Policy - > 3 SEIM Splink
> 1 SEIM Elastic
Cient Forwarding Policy LA VESSer: gl el
Iseiation Policy
LB, y & KLAS - ZT at the Tactical
> 7 RODP SSH via 2CC
Radicection Policy y 8 Privilege Remote Access
®g Configuration & Contrel ¥
> 32 Copy of VPNKiBer-Intemal-Websites
E] Ciient Connector (4
& Account » > n EvilAccessPolicy

H Tools »

Figure 96. Access Policy
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MODE: This refers to the Access Policy Rule Actions:
- Allow Access
- Block Access

- Require Approval

Edit Access Policy X

Name

PEP-PDP C2C

Description

Varonis Comply to Connect

App Connectar Selection Method

re Approval

App Connector Groups. Server Groups.

Message to User

Hello User You are being blocked from Acces

Cllent Cannector Posture Profies @

Figure 97. Rule Action

6. After clicking Save, you see the final logic statement created for the policy trigger.

Tmioetamars Cumest
Enzbied  Folicy tree Esforcamaend Summary 3azia

] IP, . Acoe 1 Pans Proahald fpl mel e B D e PEPPDR S0 o Blosh e, cllwrwine bniren v
Y p——

M poliey 73 = n

Fragires) fasicd n

Figure 98. Policy Trigger

7. Click OK to save the policy.
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[ L]

Bt s ot 1 e Pl hiimas Dema 1 sinne

Figure 99. Save Policy

8. The new policy is created under the Agent with a red Unlocked icon. This means it is disabled. To turn it on, right-

click and select Lock.

=

& *

« @ Repository
¥ % Network Devices
* ¥ Okta Products
» ¥ aaesxi7
4 % Systems
« 1 Alma9 - Prod Server
-t Compliance Policy
- Eul Access Policy
a @ Client Fowarding F
w @ Isolation Policy
YL Wint1147

* % Zscaler Products

Figure 100. Lock

(JcIMTRAK

INTEGRITY, TRUST & RESILIENCY

[l Scan Details 4

Drag a column header
Name

NIST CCSF Version 11

O

Lock

Save to Template .
Reports...

Report Schedule
Rename...

Delete
Permissions_

Email...

Properties...
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CimTrak initiates the scan and completes the Benchmark/Compliance tests. After completion, you receive the Compliance
Scan Completed event in the Event Log.

Find the score in the Scan Details tab.

PeciMTRAK . .

64.9% -
Passed i

Figure 101. Scan details

i
|

Testing the Integration

Now you can test the rules.

The following example is a policy that expects a 100% PASSING score, or the ZPA Access policy triggers to Block Access
mode.

The following image shows the completed scan.

B Reposnory
P W Netwark Dinvaces
F W Okt Products

¥ ! QAESK T

+ W Systerns

4 L Blnai . Prod Sacee Severity  Detection DateiTime  Event

i * Comeliance Policy nd THAR024 1518 10 Policy Imegration Enabled ACCESS =¥ (FEP-PDH
- Access Pobcy
- @ Cherat Fowandeng Pobe
& B pastation Pobey

o - Wind1-147 I FHA024 151819 Mapping 055 4 0 faded

bW Fscaler Products

Figure 102. Completed scan
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This shows a score of 65.3% (this does not meet the 100% pass standard).

jctMTRAK

cqmd R

65.3%
Passed

Figure 103. Scan score
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The following image shows the triggered CimTrak ZPA Policy.

Drag a column header here and drop it to group by that column

-
Severity Detection Date/Time Event

nfo TH2024 15:18:19 Policy Integration Enabled ACCESS _POLICY (PEP-PDP C2C) because of ComplianceFail Threshold trigger
nfo 172024 15:18.19 Mappang NIST CSF Version 1.1 failed

nfo 71172024 15:18:19 Mapping SOC 2 failed

nfo TH1/2024 1561819 Mappeng PCI DSS 4.0 faded

nfo 1172024 15:18:18 Benchmark CIS Almalinux OS5 8 Benchmark / Profile: Level 1 - Server fasded

ey T12024 151815 Compliance scan completed

nfo 11172024 15:16:01 Lock Started

nfo THA2024 1516:01 Compliance scan started

nio TH1r2024 15 16:01 Lock Complete

Figure 104. Triggered CimTrak ZPA Policy

In the ZPA console, the Policy has switched to Block Access mode.

Edit Access Policy

Description

Waronis Comply to Connegt

App Connactor Selection Method

Require Approval

fic App Connector Qroups or Server groups for the -

App Connector Groups Server Groups

SiyTap Ent -

Message 1o User

Hella User You are being blocked from Accessing DOD Data because of unexplained Activity. Please call helpdesk! 1800 HelpDask

CRITERLA

Client Connector Posture Profiles @

PEP-DEP ¢-C2C Check (zscalertwo - z WERIFICATION FAILED

m :H.I;:?:

Figure 105. Block Access mode

©2024 Zscaler, Inc. All rights reserved. 64



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

Resetting the Integration

While you can change the Rule Action status within ZPA, there is also an option to do it in the CimTrak Web Console.

1. Right-click Repository, then select Compliance Policy and Properties.

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

¥ L8 |l Scan Details

« @ Repository
' % Network Devices
» % Okta Products

r ¥ oaEsxi7
Drag a column headei
4 W Systems
“4 & AIma9 - Prod Server Name
(PR Compliance Policy 4

w 2 Access Policy

A ~r . Unlock and Allow Changes
- Client Fowarding Pc

& Force Sync
w U |solation Policy

» L wint1-147
Save to Template...

» % Zscaler Products Ranod. E
]

Report Schedule

Permissions...
Email...
Jm
Figure 106. Properties
2. Click the Integrations tab.
a Mama Typs
Terang Puss
Tiie Cwbioripmos Versos Profie
1 F5 P
P Addresy BIT00 0 | Curmest Sarmer ’ i Savves | Curreen Crodentiais: Dels
Legend
Biniy Beuplay Appicable Benchmarks B
B ARy Ratesmis Dayt [0 & Datiult]

Figure 107. Integrations
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3. View the current ZPA Policy status. Click Reset to undo the action.

Enfimtavwaras Currer
Enabied  Falicy tree Enforcemant Susmary Sixin

Figure 108. Reset

Integrating with Client Forwarding Policies

To integrate with client forwarding policies:

1. Select ZPA-Client Forwarding and click Add.

New policy: ZPA - Client Forwarding v

Figure 109. Add ZPA-Client Forwarding

2. The following dialog displays. Configure how you want this integration to interact with your policy.

Kb g 1w e whern g o e g

Figure 110. Client Forwarding Policy
The configuration uses a logic statement that you can configure and change with a drop-down menu, as follows.

If a <COMPLIANCE TRIGGER> occurs, then trigger Zscaler rule <ZSCALER CLIENT FORWARDING POLICY> in
<MODE> mode, otherwise leave the policy in <MODE> mode.

Automatically reset when above condition is no longer met: This setting disables the ZPA policy if the system
is in a PASSING state for the configured compliance policy.

These variables are defined as follows:

COMPLIANCE TRIGGERS: There is only one Compliance Trigger:

- Pass threshold not met: This means the Compliance/Benchmark scores do not meet the configured
threshold in CimTrak, and triggers the ZPA Policy. You can configure this threshold in the Repository
Properties.
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Right-click Repository in the Tree View on the left, then select Compliance Policy and Properties.

CIMTRAK

RITY TRUS

vl A

« @ Repository
¥ % Network Devices
¥ % Okta Products
» ¥ Qaesxi7
4 % Systems

- . Alma9 - Prod Server

PR Compliance Policy
a® Access Policy
a @ Client Fowarding Pc
a® Isclation Policy
» L wint1-147

¥ % Zscaler Products

Figure 111. Properties

4. Click the Compliance tab.

ESILIENCY

Ll Scan Details

Drag a column headei

Name

Unlock and Allow Changes
Force Sync

Save to Template...
Reports... VE
Report Schedule

Permissions...
Email...

Loggey Memoea sarew @

M of Erpemy % aag
Erubin Loggeng Teiie
L A D CRBASL
B Eroisce Events Aaocased Te Dot

L L

I, LI TP e Fromcei

Purge Log P Abar oy

Donptoy Piame  From Adwewss D v jo e ot e W ey S Faiirn

Figure 112. Compliance tab
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5. Configure what test percentages equate to a PASS value. The default is 100%.

CimTrak Repository Properties

# Logging = General & Pa:

4, Installation Key 0 OS Specific #, Compliance & Integrations 8s

Allow Remote Compliance Sources [ (7]
Default Collector aimag.50 v @
Save ARF (Asset Reporting Format) Results (] @

Keep  pp megabytes of ARF Results.

Benchmark Pass Threshold 4 % @

Mapping Pass Threshold 100 o, @

Policy Group Threshold 449 % @

Enable Auto-Update For C i Content i ] @

Enable Auto-Update of Existing G Policies and ) to Newest Versions Upon Receipt (] @
Figure 113. Pass thresholds
ZSCALER CLIENT FORWARDING POLICY: This drop-down menu populates the available access policy found in
your ZPA environment:
- Client Forwarding Policy 1
- Client Forwarding Policy 2
- Client Forwarding Policy N

Access Policy Timeout Palicy | Client Forwarding Policy | Isolation Policy Security Pol 2!

> M

Rule Order HName

> 1 Outage-EackupServer-Rerute

> (-

Name Rule Action

Descrigtion

i thet 4ol
Segment Groups
iguration & Control » Aevy Segment Group
B Client Connector [
L2 By hap

Clenst Types
Ary Ciant
Machine Groups.
Arvy Mac
Plaitorms
Aryy Pattn

Figure 114. Client Forwarding Policy
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MODE: This refers to the client forwarding policy rule actions:
- Forward to ZPA
- Only Forward Allowed Applications

- Bypass ZPA
Name

Outage-BackupServer-Reroute

Description

test

ACTION

Rule Action

Forward to ZPA Only Forward Allowed Applications O Bypass ZPA

CRITERIA

EEUGE  Cancel

Figure 115. Edit Client Forwarding Policy

6. After clicking Save, the final logic statement is created for the policy trigger.

Erviroement Curmern
Ersbind Py type Erbimpomest Somm iy frane

B i - Chont t a Paa Sreahokd not met 1 then g Jacakr nic Chtage-Backup Server-Sercets 1 Forward o 2Pk mods n m
s wrutne e e L

e =

Figure 116. Policy trigger

©2024 Zscaler, Inc. All rights reserved. 69



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

7. Click OK to save the policy.

Frdsrcamann Cuirent
Erabied  Posey type Ertircmard Lumemary -

] 3 s rwshas ot e

. s Jaca Drage- B30k barenr Rarvea o Farwarg v IPh ro ﬂ ﬂ
v 1 Bypass T4

T

Figure 117. Save the policy

8. The new policy is created under the Agent with a red Unlocked icon. This means it is disabled. To turn it on, right-
click and select Lock.

@ CIMTRAK

INTEGRITY, TRUST & RESILIENCY

el S [l Scan Details

< @ Repository
¥ % Network Devices
» % Okta Products
» ¥ oaEsxi7

Drag a column header
4 % Systems

4 &« Alma9 - Prod Server Name
@ % Compliance Policy NIST CSF Version 1 1
& Access Policy Lock @

a Client Fowarding F
- al Isolation Policy
¥ L Win11-147
b %> Zscaler Products Save to Template...

Reports. ..
Report Schedule
Rename...
Delete
Permissions._.

Email....

Properties...

Figure 118. Lock
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CimTrak initiates the scan and completes the Benchmark/Compliance tests.
After it is complete, you receive the Compliance Scan Completed event in the Event Log.
Find the score in the Scan Details tab.

BecimTRAK ‘ <

64.9% -
Passed i

B
. i -

i

Figure 119. Scan details tab

Testing the Integration

You can test the rule. The following example uses a policy that expects a 100% PASSING score, otherwise the ZPA Client
Forwarding policy triggers Forward to ZPA mode.

D CIMTRAK

Figure 120. Policy trigger
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The scan shows the score is 65.3% (this does not meet the 100% criteria).

jc:M‘rRAK A =

:*,L.T,F._ - — LI S — [ b -
r =3
. 3
=
65.3%
Passed
Figure 121. Scan score
You can see CimTrak triggered the ZPA Policy.
Crag a column header here and drop it to group by that column,
Severity Dutec!ianEn!n"ﬁ me Event
Info THA2024 15:34:21 Mapping PCI DSS Viersson 3.2.1 failed
17202 21 Mapg MNIST C5F Wi failed
| 172024 15:34:21 D S0C 21
024 15:34:21 Poboy Inlegrabon Enabled BYPASS POLICY (Outage-BackupServer-Renpute) because of ComplanceF alThaeshold tngper
I 712024 153420 | Benchmark CIS Aimalinux OS 9 Benchmark | Profile: Level 1 - Server failed
11 4 153417 Co iMCE SCAR o =
I TH12024 15:31:55 zompliance scan staried
TH12024 3 k Started
Indo 1172024 15 5 Lock Compl

Figure 122. Policy triggered
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In the ZPA Admin Portal, the policy has switched to Forward to ZPA mode.

Edit Client Forwarding Policy X

Name

Outage-BackupServer-Reroute

Description

tast

ACTION

Rule Action

& Forward to ZPA Only Forward Allowed Applications Bypass ZPA

CRITERIA

Figure 123. Forward to ZPA

Resetting the Integration

While you can change the Rule Action status in ZPA, there is also an option to do it from the CimTrak Web Console.

1. Right-click Repository, then select Compliance Policy and Properties.

CIMTRAK

INTEGRITY. TRUST & RES

| A Ll Scan Details

a Repository

Pl

-

% Network Devices
¥ Okta Products

v

r ¥ oaEsxi7
Drag a column heade!
4 % Systems
« 1 Alma$ - Prod Server Name
WA Compliance Policy 1

W@ Access Policy

an Unlock and Allow Changes
& " Client Fowarding Pc
Force Sync

@

@ U |solation Policy

» L owintio1a7
Save to Template..
¥ % Zscaler Products Reports .
e )

Report Schedule

Permissions..
Email..

Properties

g

Figure 124. Properties

©2024 Zscaler, Inc. All rights reserved. 73



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

2. Click the Integrations tab.

Tetang Puss

Vinrsios Profie

T Cwscripmos

Cumrum Coederaiaiy. Dmia

P Aaddresy: K700 0 | Current Buanner: Areal

Legend
L] -
L ]

Bty Denplay Appicable Benchmark: B

Wi By Rstariies Dyt [0 & Dutpu) .

Figure 125. Integrations

The following shows the current ZPA Policy status. Click Reset to undo the action.

i PERSTE CHC n Block

Esitied  Puoliy typs Erdgrimmard Summary

] * 5 Pasa hemshoid not st o
Al e

e y -

Figure 126. Reset
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Integrating with Isolation Policies

To integrate with isolation policies:

1. Select ZPA-Isolation and click Add.

ZPA - Isolation W m

Figure 127. ZPA-Isolation

MNew policy:

2. Configure how you want this integration to interact with your policy.

v uning Tucaier molinon Frodie v - w -

Figure 128. Configure integration

This is a logic statement that you can easily configure and change with a drop-down menu, as follows:

If a <COMPLIANCE TRIGGER> occurs, then trigger Zscaler rule <ZSCALER ISOLATION POLICY> in <MODE>
mode, otherwise leave the policy in <MODE> mode.

Automatically reset when above condition is no longer met. This setting disables this ZPA Policy if the system
is in a PASSING state for the configured compliance policy

The variables are defined as follows:

COMPLIANCE TRIGGERS: There is only one Compliance Trigger:

- Pass threshold not met: This means that not meeting the Compliance/Benchmark scores of the configured
threshold in CimTrak triggers the ZPA policy.

Configure this threshold in the Repository Properties. Right-click Repository in the left-side Tree View and
select Properties.

@cimTRAK

@ - Ll Dashboard

« @ Repository

b W Networl
* ¥ Okta Pr
» ¥ oaEs
“ W System
= - Alme
& @

a®

3 ”(—

P4 Winl

b W Zscaler

New > +
Change View >
Lock All

Unlock All

Force Sync On All
Cancel All Locks

Agent C

Reports.

Report Schedule
Upload App

Bulk Operations >
Permissions

Email...

Maintenance =

Figure 129. Properties
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3. Click the Compliance tab.

=] s Diaplay Ml Procs hidbess  Dnalmeraimsl Rogeve B s Emcias B Rlowry O Py

e
Laggesg Merzan Sarew B Fam Tggar Leval
Bagies TA
- sy v
Wi TP et Fromool v
M of Erpemy % aag -
Erusbin Loggeng Ts o Purgs Log Py, Afwr Bays

L N

Cobman Ermmal Taks Syvm

G Actmmatessy Upimad Cusgrants Sota t Comam e G

Figure 130. Compliance

4. Configure what test percentages equate to a PASS value. The default is 100%.

CimTrak Repository Properties

Allow Remote Compliance Sources [ @

Default Collector 00 5p) v @
Save ARF (Asset Reporting Format) Results [ @
Keep  qpp megabytes of ARF Results.
Benchmark Pass Threshold  4pg % @
Mapping Pass Threshold 100 % @

Policy Group Thrésheld  4np % @

Enable Auto-Update For Compliance Content (Mappings/Benchmarks) [ @

Enable Auto-Update of Existing Compliance Policies (Mappings and Benchmarks) to Newest Versions Upon Receipt || @

Figure 131. Compliance values
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ZSCALER ISOLATION POLICY: This drop-down menu populates the available access policy found in your ZPA
environment:

- Isolation Policy 1
- Isolation Policy 2
- Isolation Policy N

.q:.\ Access Policy Timeout Policy  Client Forwarding Policy | Isolation Policy

Zscaler Private Access

> No
@ Dashboard
® Insights Rule Order Name
k¥ Analytics > 1 rowser Isolation Elastic
B Authentication »
> 2z Browser |solation Splunk

#h Resource Management #

& Policy -

Access Policy

- ame Rule Ac!

Timeout Policy
Chient Forwarding Policy Default_Rule RULE A
Bypass
Isolation Policy Deseription J—

£ = Thi he default Isclation Policy rule
Security Policy his is the default Isclation Policy r

Privileged Policy

Redirection Policy

Figure 132. Isolation Policy
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MODE: This refers to the isolation policy Rule Actions:
- Allow Isolation

- Bypass Isolation

Edit Isolation Policy X

MName

Browser Isolaticn Elastic

Description

Browser Isclatien Elastic

ACTION
Rule Action Isolation Profile
@ Allow Isolation Bypass Isolation Read-On Iy -
CRITERIA
Application Segments €@
SEIM - Elastic X
g Ly
Segment Groups
Select one or more [ -

BRI Cancel

Figure 133. Isolation policy rule actions

5. Click Save to show the final logic statement created for the policy trigger.

Entorosment Carreet
Ensbled  Poboy fype Entoramest bummary B

Srwpabey] PR e ﬂ

Figure 134. Final logic statement
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6. Click OK to save the policy.

Frdsrcamann Cuirent
Erabied  Posey type Ertircmard Lumemary -

] 3 s rwshas ot e

. s Jaca Drage- B30k barenr Rarvea o Farwarg v IPh ro ﬂ ﬂ
v 1 Bypass T4

T

Figure 135. Save the policy

7. The new policy is created under the Agent with a red Unlocked icon. This means it is disabled. To turn it on, right-
click and select Lock.

@ CIMTRAK

INTEGRITY, TRUST & RESILIENCY

el S [l Scan Details

< @ Repository
¥ % Network Devices
» % Okta Products
» ¥ oaEsxi7

Drag a column header
4 % Systems

4 &« Alma9 - Prod Server Name
@ % Compliance Policy NIST CSF Version 1 1
& Access Policy Lock @

a Client Fowarding F
- al Isolation Policy
¥ L Win11-147
b %> Zscaler Products Save to Template...

Reports. ..
Report Schedule
Rename...
Delete
Permissions._.

Email....

Properties...

Figure 136. Lock
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8. CimTrak initiates the scan and completes the Benchmark/Compliance tests. After completion, you receive the
Compliance Scan Completed event in the Event Log. The score is found in the Scan Details tab.

@cIMTRAK

64.9% 5
Passed ]

e gr e

Figure 137. Completed scan

Testing the Integration

You can test the rules.

The following example uses a policy that expects a 100% PASSING score, otherwise the ZPA Isolation policy is triggered to
Allow Isolation mode.

The following image shows the completed scan.

.;'-’MMTHAK

& . Dot -

o —
"W Nesanrt Desves
* W Qs Products

* ¥ papsay

* W Gumwems =

L ibenad .. Pocd Sores Swvwnry  Dewbcnion Do Ties  Event

& " pooess Polcy
& 1 Gl Eg wardng Policy
& ¥ hoaron Palcy

v L Wintoat

* W Dacale Products

Figure 138. Completed scan

©2024 Zscaler, Inc. All rights reserved. 80



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

The score is 65.3% (this does not meet the 100% criteria).

DcIMTRAK : .
) i
i : =
r =2
£ =
=
65.3%
Passed
Figure 139. Scan score
You can see CimTrak triggered the ZPA Policy.
Dwvag & column header here and drop it bo gioup by thatl colurmn
Severity DltwhunE;hl"ﬁmn Event
‘] 117202
)2 A OLICY 3 as 2 ancefF a
i 11202
WIS SF W 1 nled
1 M12024 15:46.56 enchmark CIS Almalnux OS 9 Benchimark | f L 1 - Server faded
g 24 15:46:¢ Tt
3 12024 15 : o
130 .

Figure 140. Triggered ZPA policy
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In the ZPA Admin Portal, you can see the Policy has switched to Allow Isolation mode.

Edit Isolation Policy X

Hame

Biowier |Solation ELastic

Description

Browser Isolation Elastic

Rule Action

AR Bypass olation

Application Segments 0

Segment Groups

Clignt Typas

Cancel

Isolation Profile

Figure 141. Allow Isolation mode
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Resetting the Integration
While you can change the Rule Action status within ZPA, there is also an option to do it from the CimTrak Web Console.

1.

2.

Right-click Repository, then select Compliance Policy and Properties.

e

CRITY, TRUST &

A * bl Scan Details
« @ Repository
» ¥ Network Devices

* % Okta Products

» ¥ oaesxi7
Drag a column heade:
“ W Systems
4 & AIma¥ - Prod Server Name
a4t Compliance Policy 1
o @ Access Policy
P . ) Unleck and Allow Changes
W T Client Fowarding Pc
P Force Sync
w - |solation Policy

» L win11-147

* W Zscaler Products

Save to Template..
Reports. . IE
Report Schedule

Permissions...
Email...

Properties

Figure 142. Properties

Click the Integrations tab.

Q e Troe
o
Lini & Veruons L")
b Pglcy Ceosn
q '
'
Taitng Pue
T Daterpeon Neruon Predis
B Ahsdreis. | Cusresl Biasner. g Corresd Cradastinhi Colest
Lo = e

Ondy Omplyy Appicabia Banchmarny ([0

B Heitory Resbstion Syt [§ = Sufitn

Figure 143. Integrations
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3. You can see the current ZPA Policy status. Click the Reset button to undo the action.

Emabisd  Poday reps Ertnsniman Tammiy e

Figure 144. Reset status
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Configuring ZIA and CimTrak

The following sections describe how to configure ZIA and CimTrak.

ZIA Integrity Monitoring

CimTrak CimTrak
User Provides CimTrak Checks ZIA 'Prowdef
ZIA Tenet A Configuration Side-By-Side
. Baselines ZIA 4
Credentials to e ration to User Comparison to
CimTrak 9 Specified see EXACT
Interval Change
ZIA Integrity Trigger
User Provides User Creates User Creates ’ K
ZIA Tenet Integrity Policy Device Postures C:1mTra
Credentials to for a System in to Track CimTrak / . Cl a.ng:s
CimTrak CimTrak Integrity Suite RSty State
ZIA Compliance Trigger
User Provides léiiclriea:t:: Us'er Creates CimTrak .
ZIA Tenant e P i Device Post:res Changes :IA Iso at-es
Credentials to s s::rn in tt_’ S Compliance y.stem s
CimTrak Y Cln:nTrak. State Device Posture
CimTrak Integrity Suite

Figure 145. ZIA and CimTrak monitoring flow

Monitoring ZIA

The following sections describe how to monitor ZIA.
Login CimTrak Console
Go to the CimTrak Web Console for your environment and log in as a CimTrak Administrator. For example:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

Plaase Login

Figure 146. CimTrak Web Console
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Creating CimTrak Integrity Policy
After logging in to the dashboard:

1. Right-click Repository in the Tree View and select New > Device & Policy.

2. Click Integrity Monitoring (Agentless).

New Device and Policy

Create an Agentiess Integrity Monitoring Device and Policy
This option does not require any CimTrak components installed on
the target host. Instead, it relies on a CimTrak Collector on your
local network to monitor objects such as network devices, swilches
routers, ESXI hosts, cloud infrastructures, Docker hosts, and
Kubemetes hosts via a CimTrak collector.

Create a Compliance Target and Policy
Choose this option if you wish to configure SCAP content

* (benchmarks) to run either Agentiess or on an installed CimTrak
Compliance Agent

Figure 147. New Device and Policy

For Device Type, select Zscaler.

For Zscaler Product, select ZIA.

Input the ZIA Endpoint/Username/Password/API Key previously gathered.
Choose the Output Format (Zscaler recommends Properties Format).
Click OK.

N o oA W

Plugin Properties

Device Type = Zscaler w
§
Zscaler
Zscaler Product ZIA v |
Z14 Endpoint https://zsapi.zscalertwo.net
Z1A Username cimcoradmin@vpnkiller.net
ZIA Password ]
ZIAAP] Key srsmsssrsnrnn
Qutput Format: Properties Format (Easier to Read & Compare) w

Figure 148. Plugin Properties
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8. Click the Arrow next to /DeviceRoot. This shows what is available to monitor. Zscaler recommends selecting the top
checkbox next to /DeviceRoot to monitor all ZIA configurations.

9. Deselect Configurations for anything you want to exclude.

Dwvien Tyiep i P

Promsd ran

Bols umchEuciode B Fars  AddWans By Puy A Dwwiiory Exciode Ba Pam s P Eciate By o em OopcrTyps  Type Eachste Basssn bacea F it Comects Aumsn Domactas

B W wis ros

B

Figure 149. Policy Properties

10. Upon selecting the checkbox, you must configure the Watch Properties. Zscaler recommends choosing Log mode.

1. Change the Poll Detection (interval) to have CimTrak check for Zscaler changed to an interval of your choice. The
default is every two hours (02 hours and OO minutes).

12. Leave all other default settings, as they are not relevant for this integration.
13. Click OK.

When a change scours Some softwane, suUCh an backup utilities oo vinss detection software, modify various file
attributes. which will signal an intrusson 1o Cim Trak
Updats Bassine Igrveere Archive Flag lgree Read-only Flag
Raatare from Repontory fgmere SACL fgnars DACL
Nutly ol Kgrars Dumid Lacurtty Kgrses Qroup Sacurtty |
e igrions Anemate Stream Oats igrises Fils Dates
Mathariiatvs Copy Evant Datection Method
Pl inserval (Howrs and Minues)
® S2ore suthoritative copy of 3il fles i the CimTrak Repositony, This will allow Cim Trak et tma Detectice
15 racseore flles Back 15 Mailr orighnal st L -
Dant Sore suthertatve sopy Poil 1 Spacific Tima Lecal Time gn 02 ]
Agent) " -
Foll 31 Specific Time (UTC Time|
Steve Changes Other File Compariten Method
B Store a copy of addedichanged Log Rests SHAZSE s
L \gnare Read Directores
Suppress Syne San d Syne
Compists Mastages
Auts Exthete
At wxehute Ses That have eharged tmes in B0 minctes

Symbsle Links

Follow Symbolc Links Limvued Depth

# Unlimited Dagth
| o |
Figure 150. Watch Properties
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14. Give the Device a name (e.g., Zscaler ZIA).

Policy Properties

FH Policy i Attributes LE Integrations

Device Name | Zscaler ZI4 Device IP | |IP of Virtual C

o

Add Watch By Path  Add Directory Exclude By Path  Add File Exclude By Path

* ¥ & /DeviceRoot

Figure 151. Device Name

15. Click OK.

Enabling CimTrak Integrity Policy

The policy must be monitored. To enable the policy to start its monitoring intervals:

1. Right-click the policy name and select Lock and Digitally Sign. It takes an initial baseline and then monitors on the
configured schedule and reports on any deviations since the baseline.

% - @ Monitor Ini

4 |8 Repository
¥ % Network Devices ftem
¥ % Okta Products » [Devic
» ¥ oaesxi7
P % Systems

%> Zscaler Products
4 ¥ 7scaler: Product ZIA

= D policy

4 ! Zscaler: Proc  Lock and Digitally Sign...

Save to Template...
Reports...

Report Schedule
Rename...

Delete
Permissions...

Email...

Properties.

Figure 152. Lock and Digitally Sign
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2. Watch the progress in the Status Window for completion.

\ECIMTPAK

Figure 153. Status window

3. When complete, you see the policy change from a red Unlock icon to a blue Lock icon. It continues to check on
your specified interval. You see the Sync Start message in the Event Log to indicate progress.

S L

& ! & Monitor Info B4 Event Log = Change Log @ Pending Operz

« @ Repository

b ¥ Network Devices Filter: Last 90 days w
¥ ¥ Okta Products
y W
& QAESXIT Drag a column header here and drop it to group by that column
P Systems —
4 B Zecaler Products Severity Detection Date/Time Event
« W Zscaler Product ZIA Info 7/5/2024 00:01:08 Sync Complete
D Poli
- e Info 71412024 23:59:32 Sync Started
» ¥ zocaler Product ZPA
Info 71412024 22:03:10 Sync Complete
Info 71412024 21:59:31 Sync Started
Info 71472024 200117 Sync Complete

Figure 154. Complete Sync
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Reviewing the Change Log
After CimTrak starts detecting changes, they are reported in the Change Log.

The following image shows the time CimTrak detected the change, and the Absolute Path indicates what changed. These
are the same categories of ZIA configurations you saw when creating the Integrity Policy initially.

Sl LR LS

@ - B Monitar Info [ Evenit Log = Changé Log @ Pending Operabons i Generaton & fuithondative B
« @ Repasiory
bW Network Devices Filter: Last 90 days -
W Dikia Products
r ¥
< CAESKIT Drag a column header here and drop it o growp by that column
W Systems -
4 B Fecaler Products Severity Detection DateiTime Ewvent Absolute path
+ W Zecaler Product ZIA Waming  T/2024 1500000 File Modifsed DewviceRootTrata Loss Prevention/Dip Notification Templates
g
- oy Warning TiR2024 1350 54 Fre Modifed MeviceRootTData Loss PreventionDip Engines
v ¥ Zecaler Product ZPA
Wairning TI82024 11:59:52 File Modified DeviceRootTata Loss Prevenuon/Dip Dicticnanes
Winrmning 182024 11:59:50 File Modified DeviceRoolBrowser IsclatonProfiles
Waming  TIB2024 11:559:48 File Modisad DewiceRtootiddmen & Role Management’Admin Lisers
Waining TIR2024 11:59:48 File Modifhed MDenteRootiAdmn & Role ManagementLie
Waming  T/82024 11:58:44 File Moddsed DessceftoolActvationSatus
Wamning TE2024 0200018 File Modfad DewceootThata Loss Prevenbon/Dip Engnes
Waming TIRr2024 02:00:17 Fili Mo DeviceRootTrata Loss Prevention/Dip Dictionaries

WWa FIRR024 02:00015 Fil Mo Dewiceriaol abaonPrafiles

Waming TIE2024 0200013 File Moddsed DewceRoot!&dmn & Rale entfdmin User
Waming  T/A2024 02.00012 File Modied DeviceRooliAdmin & Role Management/Lile

W THR2024 0200010 File Modified D ACtreation

Waming  T72024 235649 File Modified DeviceRootData Loss Prevention/Dip Engnes
Warming TITI2024 235047 File Modifhed (DenceRootTata Loss Preventon/Dip Dictionanes
Waming 772024 23,5645 File Modiied DevceRoolBrowser IsolabonProfiles

Waiming TIT2024 23:50043 Fie Modibed DewceRootAdmn & Role Management/Admin Lisers
Wairning TIT2024 2358041 File Modified DewiceRool'fdmin & Role Management/Lile
Waming  TITR2024 2350039 Fila Modfed (DesiceRootActvationSatus

Waming 72024 14:00005 File Modfad De ﬁ‘.,:_:;.,-.,: AL AN SIS

Waming TITi2024 10:00007 Files Modified (DeviceRoot'Admin & Role Management/Lile

Figure 155. Change log
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Right-click an event and select Compare Against Previous State on Agent to see a side-by-side comparison of exactly

what changed.

DcimMTRAK

bW Network Devices
 Dita Products
¥ aaEsnoT
P W Syshems
¥ Iscaler Products
* ¥ Zecaler Product 1A
a ! Tecaler, Product IPA
& D policy

[1] hor Il ™ Event Log = Chamnge Log ) P 3 O B iy
Fittar Last ©0 days -
Drag a colurnn header here and deop it to group by that column
-
Sevarity  Detection Data/Time  Absolute path

Wamsng  B2052024 175804

Wamng  GO%0004 155803
Waireng BZS2024 141000
‘Waming G500 140805

Warming 6252024 140854
Wameng G504 140853
Waming  G252024 115756
Waming  GO52004 115756
Wamsng 82502024 35T 56

Wameng BRS04 075755

Figure 156. Compare Against Previous State On Agent

DinaceRlootlApp Conneciorn Contnollan Connacior
DencehlootiApp Connecior Controllen'Connecion
DinaceR ootServer Gooup ComrollenServer Group
DaraceRlootApp Connecior Condroller'Connecion
DevneeRcotSegment Group Controller Segment Groug

Dirvarh oot A ppdecatinn Controlle i abon

] ¥ Aijitoiiatrse Dasehne
Evanit Cormection
Fiber Macsiflad Basahie Updated
Fib Fbiedadandd Basehne Lipdated

Fubir Fliachibuing] B Lpolaged

Fibix Flcahilinsdl Basehne Updated

Share
Demote From Authoniaies Bagsine

DevnceRootApp Connecion Connollen Connecior

DraceRoctiApp Connecion Controllen'Connectcs
DeviceRootlipp Connecior ControllanConnecios

MDeviceRcclipp Connecior ControllenConnecice

The following image shows the side-by-side comparison window.

yars gt Prions 5 |
Compang Agains! Curent Stabe On Agent \‘j
Comparg To Ciher Garerataon

Wit Pl

Dowmigad File

Figure 157. State changes
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ZIA Integrity Triggers

The following sections describe how to configure ZIA integrity triggers.

E This feature is for Windows Agents only.

Log in to the CimTrak Console

Go to your CimTrak Web Console in your environment and log in as a CimTrak Administrator. For example:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTECGRITY, TRUST & RESILIENCY

Figure 158. CimTrak Web Console
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Creating CimTrak Integrity Policy

In the left-side Tree View, find the system in question that you want to create a policy for.

1. Right-click the <agent name>, and then select New > Policy.

CIMTRAK

INTEGRITY. TRUST & RESILIENCY

& A @ Info 9 Event Log = Change Log

- !
..‘fe:ij:::( PEuises Operating System: Almalinux 9.3 (Shamrock |
» % (Okta Products

» ¥ oaesxi7

4 W Systems Agent UUID: 2d7d65d8-a943-434b-82eb-beebt

4 & Alma9 - Prod Server
<
0 F

J
¢ 7/110/2024 10:56:24 (5 hours 2

AgentIP: 127.0.01

R Compliance New > I Policy

w® Access Polic  LockAll..
g Client Fowar  Unlock All

& @ 1solation Pol  Force Sync On Al »d Time: 7/10/2024 15:57:10 (2
4 Win11-147 Cancel All Locks

& ™ Compliance  Save FIM Policies to Template

ad Access Polic Reports...

& @ Client Forwz  EPort Schedule

- & Isolation Pal Tags... nents:
» % Zscaler Products Rename
Delete
Permissions... nt
Email...

Maintenance >
Properties...

Figure 159. Policy

2. Click Integrity Monitoring (Agent Based).

New Policy

Create an Agent based Integrity Monitoring Policy

Choose this option to monitor things such as the registry, file
system, and installed software. This is a freeform policy. Choose
this option if you know which components and paths you wish to

monitor,

Create an Agent based Integrity Monitoring or Compliance
Policy via Template

This allows you to create predetermined polices from a premade
template. These templates can be created by the user or may have
been provided with the inital install of CimTrak

Create/Edit a Compliance Policy
Choose this option if you wish to configure SCAP content
{benchmarks) to run either agentless or on an installed CimTrak
Agent.If this node has a CimTrak Agent installed with the
compliance compenent, the scan will be performed from the locally

installed agent; athenwise, it will be run from the CimTrak Collector.

Figure 160. Integrity Monitoring (Agent Based)
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3. Select the folder or object that you want to monitor. In this case, it is a folder on a Windows system.

Policy Properties

B Policy i Attributes % Integrations
Policy Name Name of Policy

Bulk Watch/Exclude By Path ~ Add Watch By Path 2

4 i A
v i SRecycle Bin
» Ol swinREAgent
» Ol Application-Files
r LIl CIMCORFILES
v i CimTrak
4 Dl DEMO Palicies

b -
4 ™
] ™
3 ]
’ %— Test Folder
3 ]

» L1l Documents and Settings

Figure 161. Policy Properties

4. In the Watch Properties dialog, select the monitoring options. For this example, select Log mode and leave the
other field defaults.

5. Click OK.

When 2 change aceurs Same poftwars, uch 23 baskup wbliies or virus SesecEon eftwar, maddy various flg
Bnribes. which will wigral B intrueon 19 Cim Tras
# Leg
Upsdaie Bazeiene ignaes Archive Fiag ignore Read-ceily Flag
Fiestors inom Reposiory Ignoes SACL ignore DACL
Moty Only Ignare Caner Security ignore Group Security 1
Cuntem Ignese Alternate Stream Dats tgnere File Dates
Butheritates Copy Evant Dinteetion Wathod

Stavw mithortative eopy of ol Bles i the ComTrak Repeaitery. Tha will alkew Cim Trak Real-time Drtection

10 restnee Tiles Back 10 their Drigensl state Pl Drtection interval]
¥ Dot Stare sutheritative sopy Pl at Specifir Tms [Local Time on
Ague

Padl 3t Specific Time [UTC Tima)

S1oee CRanges Cahar Fiia Comparistn Mamod
SI0 3 Copy Of edENInged L Reads SHAZH -
e

igrore Read Dirsciones

Supgress Syne St & Sync

Compiete Mrriages

At Exclude

Aty Enhad NS That have Changed nmes in B0 minuses.
Symbadic Links

Follom Symiols Linky Liméind Capih

® Uniivites Daptn

Figure 162. Watch properties
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6. Enter a Policy Name. Don't click OK.

Policy Properties

B Policy i Attributes € Integrations

Policy Name

Bulk Watch/Exclude By Path  Add Watch By Path  Add Directory Exclude By Path  Add File Exclude By Path

« Bl cy

»

a

O
O
O
O
= (S5
[OF]

$Recycle.Bin
SWinREAgent
Application-Files
CIMCOR FILES
CimTrak

DEMO Policies

* D@ TestFolder

L4 -

[0 Documents and Settings

O Program Files

O Program Files (x86)
O ProgramData

O RansomWare-Example

m &) Recovery

O reports

o< System Volume Information

O Tools
» O Tuning -
B Watched in this group

Watched elsewhere

Figure 163. Policy name

Configuring Zscaler Integration

To configure the Zscaler integration:

1. Click the Integrations tab.

Eacieie Bepras Beefies  Commire Auies

B Frcesi i ri g

L .

Figure 164. Integrations tab
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2. Choose ZIA - Registry Key Set and click Add.

am iy B e |

Figure 165. ZIA - Registry Key Set

3. The following window is displayed. Configure how you want this integration to interact with your policy.

v otown. e g Daotler I = e perwas e fa ooy - e

T Ty |

Figure 166. Set Policy
This is a logic statement that you can configure and change with a drop-down menu, as follows:

If an <INTEGRITY TRIGGER> occurs, then trigger Zscaler in Active mode, otherwise leave the policy in Inactive
mode.

These variables are defined as follows:

INTEGRITY TRIGGERS: These are the CimTrak Integrity options to trigger the policy.
- Change: If any change that deviates the baseline
- Denied List Item Found: If any change was a matching hash in the CimTrak Deny List (denylist).

-Not in allowed list: If any change was NOT a matching hash in the CimTrak Allow List (allowlist).

Integrating with ZIA Device Posture

Use the CimTrak Agent to automatically create and manage a Registry Key to represent the Integrity and Compliance
states. These values are then tracked via ZIA Device Postures to isolate machines based on the CimTrak states provided.
These keys are automatically created and changed based on the state of Integrity and Compliance it detects when the
policies are locked.

Registry Key Path:

HKEY LOCAL MACHINE\SOFTWARE\Cimcor\CimTrak\CimTrakAgent
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ZIA DWORD Values:

Agent Running: Either O or 1 (O = shutdown, 1= started)
Configuration Assessment Score: Either O or 1 (O = compliant, 1 = noncompliant)

Integrity Score: Either O or 1 (O = no violations, 1= integrity violation)

Registry Editor - a X
£Gisty
File Edit View Favortes Help
CormputerHEEY_LOCAL_MACHINE\SOFTWARE Cimear CimTrak\ Cirn TrakAgent
v B Computer Mame Tipe Data
HiEY_EL:;iE;}RL?S?; ab| (Default) REG_SZ {value not set)
:K :— u e 2] Agent Runming REG_DWORD 000000001 (1)
v EV_LOCAL MACHINE ] Configuration Assessment Scare REG_DWORD 000000001 (1)

BCDOO0O0000 bt '
HARDWARE ) Integrity Score REG_DWORD D Q000000 (1)

SAM
SECURITY
w | | SOFTWARE
7-Zip
v Cirncer
w CimTrak
CimTrakAgent
Classes
Clients
CVSM

Figure 167. Registry Editor
ZIA Device Postures
To set ZIA device postures:

1. From the ZIA Client Connector Portal, select Device Posture.
2. Click Add Device Posture.

<« C 23 mobileadmin.zscalerbeta.net/admin/device-posture W & 9

“= .
Device Posture

Cliant Connector
+ Add Device Posture Q_ Search by Posture name

Dashboard No. Posture Name Frequency (In Minutes) Description Actions i
@ 1 Endpoint 15 e Z o
Enrolled Devices
2 Public 15 - 2 o
& 3 Full Disk Encryption 15 - % 0
App Profiles
4 Workgroup 15 i % 0
e
Administration Rows per page: 50 » 1-dof 4 1

Figure 168. Add Device Posture
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HKEY LOCAL MACHINE\SOFTWARE\Cimcor\CimTrak\CimTrakAgent\Integrity Score

You must create a Device Posture Check for each state (1 and 0). Use the following nomenclature, or customize it for

your needs:

CimTrak Integrity Verified - GOOD state — Registry key value of O

CimTrak Integrity Violation — BAD state - Registry key value of 1

Add Device Posture

DEFINE POSTURE AND SCOPE
Name @

Mandatory

PLATFORM

Windows mac0s

x
DEFINE POSTURE CONFIGURATION

[ Apply when added as Partner Tenant @
Posture Type &
Registry Key -

Registry Key

HKEY_LOCAL_MACHINE\SOFTWARE\Cimcor\Cim...

Name

Integrity Score

DEVICE POSTURE DESCRIPTION

Linux

Android

X X

Frequency {In Minutes|

2

Match Type

Value

Data

For High/Medium Trust Only.
When CimTrak detects the system is in a state of integrity;
FRRAAAA

This is GOOD|

this key will be set to a value of 0.

Save Cancel

Figure 169. Add Device Posture

©2024 Zscaler, Inc. All rights reserved. 98



ZSCALER AND CIMCOR DEPLOYMENT GUIDE |

Add Device Posture X

DEFINE POSTURE AND SCOPE
Name &

Mandatory

PLATFORM

Windows macOS Linux Android i0s

DEFINE POSTURE CONFIGURATION

[[] Apply when added as Partner Tenant &

Posture Type & Frequency (In Minutes) (&

Registry Key - 2 -
Registry Key Mateh Type

HKEY_LOCAL_MACHINE\SOF TWARE\Cimcor\Cim... Value hd
Name Data

Integrity Score [ 1 ]

DEVICE POSTURE DESCRIPTION
For Low Trust Only.

When CimTrak detects the system has any violations caused by unexpected or unwanted changes; this key will be setto a
value of 1.

This is BAD.

Figure 170. Add Device Posture

You can take advantage of this Device Posture in ZIA. A common example is if CimTrak detects an Integrity or Compliance
violation, cut off access to all cloud apps, all internet, or certain networks based on CimTrak’s findings. In this example,
CimTrak monitors the user's endpoint (workstations or laptop). When that endpoint is in a compromised state, cut off
access in any way you specify in ZIA using this Device Posture as the trigger. The possibilities are customizable on the ZIA
side to handle what access to give or revoke based on the CimTrak triggers.

While you can use Device Posture in ZPA, that is not needed here, and Zscaler recommends you use the other
ZPA integrations in this guide.
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ZIA Posture Profile

After the Device Postures are set, create a profile to set levels of trust for systems that pass or fail these CimTrak Integrity
or Compliance checks.

In the Zscaler Client Connector Portal:

1.  Go to Administration > ZIA Posture Profile > Windows.

2. Click Add ZIA Posture.

“ .
Internet & SaaS Posture Profiles
Client Connector
macQ0SsS Linux i0s Android
i

@ No. Posture Name Trust Levels Actions i
Enrolled Devices HIGH TRUST
(Endpoint) OR (Workgroup)
& MEDIUM TRUST
. 1 Corporate Devices . . Fan |
App Profiles P (Full Disk Encryption) !
LOW TRUST
1
QE} {Public)
[Administration i
Rows per page: 50 + 1-10of 1 1 /1

Figure 171. Add ZIA Posture Profile

3. Enter a Posture Name (e.g., CimTrak Posture Profile).
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Add ZIA Posture x

POSTURE DEFINITION

Posture Name @

HIGH TRUST
EXPRESSION ®

I Select Device Posture -

© Add

Expression Preview

0

MEDIUM TRUST
EXPRESSION®

I Select Device Posture -

© Add

Exprassion Preview

0

LOW TRUST
EXPRESSION®

Select Device Posture -

© Add

Expression Preview

0

Display the required version 1
are version depe

Cancel @

Figure 172. Add ZIA Posture
There are three levels of trust in this profile, as defined in the following list:

High Trust: Passes both Integrity AND Compliance checks.
Medium Trust: Passes Integrity OR Compliance checks.
Low Trust: Passes NEITHER check.

E If you only have CimTrak Integrity features, Zscaler recommends you apply the Integrity Posture check High Trust
and leave blank Medium Trust and Low Trust.
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4. For High Trust, click Add and select both CimTrak Compliance Verified and CimTrak Integrity Verified.
HIGH TRUST

EXPRESSION @

CimTrak Compliance Verified CimTr...

Unselected ltems 2 items selected

CimTrak Compliance Verified

[~
Expr Search...

CimTrak Integrity Verified

(Ciml [ PEP-DEP ¢-C2C Check

¥ CimTrak Compliance Verified

¥ CimTrak Integrity Verified

MEDIU

EXPH

m Clear Selection

Figure 173. High Trust

5. For Medium Trust, click Add twice, once for each posture check changing the logic to OR.
MEDIUM TRUST

EXPRESSION @

ANY
| CimTrak Integrity Verified hd | o
| CimTrak Compliance Verified w | x
SADD

Expression Preview

(CimTrak Integrity Verified) OR (CimTrak Compliance Verified)

Figure 174. Medium Trust
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6. For Low Trust click Add once, and then select both CimTrak Compliance Violation and CimTrak Integrity Violation.

LOW TRUST

EXPRESSION @

| CimTrak Compliance Violation, CimT...

ANY

Expression Preview

(CimTrak Compliance Violation AND CimTrak Integrity Violation)

Figure 175. Low Trust

ZIA Isolation Profile

An Isolation profile must be configured to use an option to react to a CimTrak violation.

1.  Go to the ZIA Admin Portal.

2. Go to Administration > Browser Isolation.

L4

Dashboard

ad

Policy

Y

Administration

@

Activation

Authentication Settings
User Management
Identity Proxy Settings

Cloud Service APl Security

E Resources

Location Management
VPN Credentials

Static IPs & GRE Tunnels
Hosted PAC Files

eZ Agent Configurations

Subclouds

Network Services

Network Applications

Figure 176. Browser Isolation

Administrator Management
Role Management

Audit Logs

Event Logs

Backup & Restore

URL Categories
Bandwidth Classes
Time Intervals

Rule Labels

End User Notifications
Device Management
Risk Profiles

Tenant Profiles

Email Profiles

Cloud Applications

DLP Dictionaries & Engines

Notification Templates
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3. Click Add Profile.
BIUWSEI 1501dUOI1

Isolation Profiles Isolation Banner

® Add Profile
No. Name & Regions
1 Default Isolation Profile Frankfur

Policy

LY

Administration

Activation

Figure 177. Add Profile

4. Enter a Name and Description.

Keep Turbo Mode disabled.

6. Click Next.
Add Isolation Profile X
1 General 2 Company Settings 3 Security 4 Regions 5 Isolation Experience

GEMERAL INFORMATION

Mame

TURBO MODE

Enable Turbo Mode

DESCRIPTION

Description

Figure 178. Add Isolation Profile

7. On the Company Settings tab, click Next.
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Add Isolation Pi

1  General 2 Company Settings 3 Security 4 Regions 5 Isolation Experience

PROXY AUTO-CONFIGURATION (PAC)

PAC File URL

& Use recommended PAC file URL | ' want to use my own PAC file URL

Automatic proxy configuration URL

https://pac.zscalerbeta.netfzscalerbeta.net/proxy.pac

Override PAC file and return traffic to ZIA Public Service Edge

DEBUGGING

Enable Debug Mode

ROOT CFRTIFICATFES
Figure 179. Company Settings

8. Under Security, enable Read-Only Isolation.

9. Click Next.
Add Isolation Profile X
1  General 2 Company Settings 3 Security 4  Regions 5 Isolation Experience

ALLOW COPY & PASTE FROM

Local computer to isolation Isolation to local computer

ALLOW FILE TRANSFERS FROM

Local computer to isolation Isolation to local computer

ALLOW PRINTING

Allow printing from isolation

RESTRICT TEXT INPUT

Read-Only Isolation

'
[

Figure 180. Security

10. Enable at least two Regions the isolation profile should be available in.
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1. Click Next.
Add Isolation Profile X
1  General 2 Company Settings 3 Security 4 Regions 5 Isolation Experience

SELECT ISOLATION REGIONS

Isclation Regions

Paortland Oregon; Washington v

Figure 181. Regions

12. Select the End User Notification options for the end user’s experience in isolation.

13. Click Save.
Add Isolation Profile X
1 General 2 Company Settings 3 Security 4 Regions 5 Isolation Experience

ISOLATION BANNER PREVIEW

Heads up, you've been redirected to Browser

. Isolation!
(bzscaler The website you were trying o access ks now rendered In a fully isolated environment to

protect you from malicious contant.

Isolation Banner

Default L 4

Persist Browser Isolation URL bar
Isolation Experience

® Native browser experience Browser-in-browser experience

WATERMARKING

Enable Watermarking

Previous m Cancel

Figure 182. End User Notification
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ZIA URL and Cloud App Control
To set up ZIA URL and Cloud App Control:

1. From the ZIA Admin Portal, go to Access Control > URL & Cloud App Control.

@ Web

Malware Protection
Advanced Threat Protection File Type Control
Sandbox Bandwidth Control

Secure Browsing S5L Inspection

Data Loss Prevention

& SaaS Security API

Administration
SaaS Security APl Control

Scan Configuration

Activation
SaaS Security Posture Manage...

& Mobile

Zscaler Client Connector Portal Mobile Malware Protection

Mobile App Store Control

Figure 183. URL & Cloud App Control
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2. Take advantage of those and create policies to automate security access:
If system is Low Trust (or Unknown), Block all network protocols.
If system is Medium Trust, set the Browser Isolate to Read Only mode for all HTTP/HTTPS.
If system is in High Trust, do nothing. It's in a good state of Integrity and Compliant.
When that the Posture Profiles are assigned to the appropriate Trust level, you can trigger off of those within the Cloud

App Control Policies.

Create a Cloud App Control Policy for each Category. They should always be Rule Order 1in most scenarios per Category.
For each category you can do a Low Trust and Medium Trust rule, as follows:

E It doesn't matter if each category has different criteria, since the goal is to select any or all in every option, and to
set the Device Trust Level to Low or Medium and the access to Block or Isolate.

For any category that uses User Agent, select ALL except Other.

User Agent

Chrome; Firefox; Microsoft Edge; Micr... A

=

Chrome
Firefox

Microsoft Edge

Microsoft Internet Explorer Microsoft Internet Explorer
Microsoft Edge MS Chromium Edge
Opera
Safari

U Other

¥ MS Chromium Edge -
m Cancel Clear Selection

Figure 184. User Agent
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You can see the configuration in the following figure.

Add Collaboration and Onding Meatings Fule

Rrube Cher Rude MHame

ot
Rube Status Rube Labed

o e
Cloud Applications Cloisd Applcation Risk Prolie

e -
Users Oroups

L v -
Deparimerts Lotatagng

e , -
Lesatisn Groups i

w na e
Devices Dervios Groups

w e
Device Trusi Level Liger geni

T b w

Uper Hink Profile

Erable Bule Expiration

Application ADCess

A Feck

Figure 185. Add Collaboration and Online Meeting Rule
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You can see the configuration in the following figure.

Add Collaboration and Online Meetings Rula x

[ APP CONTROL RULE
Rl Ot Rule N
Rule Status Rule Label
Erabiled d w
RITERIA
Ciowd Applications Ciowd Application Risk Profile
Ay o Mone w
Ui Gioups
d w
Departments Locations
Wt ST W
Location Groups Timea
Ay Lo AR VS W
Darvices Dwvice Groups
W W
Dwrvice Trust Lgwvel Usgr Agent
m Trust W C ;. Firadoo; WA s0ft Edger b W
User Risk Profile
v

Enalde Rule Expiration

Apphcation Accedy

Dty Bandwidih Ouwota (ME) Dy Times Qucita [men)

Tenani Profile lsolation Prolie
i w VPR ller net - Read-only a
A :

Figure 186. Add Collaboration and Online Meeting Rule
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Log In to Zscaler Client Connector

On any endpoint where you want to enforce these rules:

1. Login to Zscaler Client Connector.

E Zscaler Client Connector

Connectivity
Username cimcoradmin@vpnkiller.net
Service Status ON (!) TURN OFF
Network Type Off-Trusted Network
Authentication Status Authenticated | £¥ AUTHENTICATE EARLY
Broker 170.85.9.249
Client 152.168.4.147
Time Connected Tue, Oct 8 2024 09:38:44 AM
Protocol TS
Notifications Statistics

Total Bytes Sent 0 bytes

° Total Bytes Received 0 bytes

Figure 187. Zscaler Client Connector

2. Click More
3. Inthe About section, select Update Policy.

E Zscaler Client Cannector - [m] X

) ST AP br -
Show Private Access reauthentication notifications (
Do Not Disturb (DND) Mode Disabled o

Advanced Settings

(~) Troubleshoot

Start Packet Capture @

nternet Security Report an Issue
_...\ Export Logs
(. Restart Service
-
\ Repair App

per Protection

Digital Experience Disable Ta

Clear Logs

o Log Mode Debug .
Motifications @ About
App Version: 4.5.0.325
App Policy: Tunnel 2.0 CimTrak
License Agreement

Third Party Software Motice

More

Figure 188. Update Policy
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Enabling CimTrak Integrity Policy

After creating the policy, it must be monitored.

To enable the policy to start its monitoring intervals, right-click the policy name and select Lock and Digitally Sign. This
starts an initial baseline and then monitors on the configured scheduled and reports on any deviations since this baseline.

i A € Monitor Ini
“« @ Repository
¥ % Network Devices ftem
¥ % Okta Products > /Devic
» ¥ oaEsxi7
¥ ¥ Systems
4 % Zscaler Products

4 ! Zscaler: Product Z1A
T Za Paolicy
» ® Zocaler Proc  Lock and Digitally Sign

Y

Save to Template...
Reports...

Report Schedule
Rename...

Delete
Permissions...

Email...

Properties. ..

Figure 189. Lock and Digitally Sign
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Testing the Integration

Test the integration. In this example, a policy was set up to monitor the directory C:\DEMO Policies\Test Folder. The trigger
is CHANGE, which sets ZIA Device Posture to ACTIVE.

This is the current state of the directory:

¥ = | Test Folder

& 1| T New item ~ W HH setect an
= 4 | Easy access - A Select none
pma‘:tg?(k Copy  Paste Bl e PICpaEE et selection
Clipboard Meéw Opén Select
Lo * » ThisPC » Logal Disk (C) » DEMO Policies » Test Folder » v O
A ik sceass », MName ¥ Date modified Type Size
B Desktop * Bank Info
3 Downloads + Impartant Stuff
Websites = | bootstat.dat
al Recycle Bin * " Configtt
1 CoreMessaging.dil
e PNt * | cryptall
bad-files debuglog
Log Made | Just an eld document txt
Restare Made | ksasetup.log
Update Bazeline Made menged.conf
4 MSWBT.dll
[ Desktop | MSWebp.dil
& Administrator | mewmdm.dil
B8 This PC | mpwsock.dil
2B 30 Objects | Patient Information. et
B Desktop ) Payroll Info.txt
5 | some-filelog
{| Documents . g
& system.ini
& Downioads = The Bank Codes.bmp
g1 Music | websenser_json.bit
= Pictures | zConfig.bxt
B videos b tHashTest.tet

Figure 190. Current directory state

If a new file is added that does not match any hash in the CimTrak Authoritative Baseline, it triggers the access policy.

7 = Manage Test Folder
“ Home Share View Application Tools
[ _-J oy Cut - x HI 3 Mew item - \/ [ open = FH select an
e w= Copy path ¥ | Easy access » . Edit Select none
k Copy Paste Move Copy Delete Rename New Properties
[#] Paste sharteu tor tav - folder - - Inwedt selection
Clipbasrd Organize New Cwpen Select
“ - 4 » ThisPC » Local Disk () » DEMO Policies » Test Folder » v O
A Jai 4 Date modif Size
T MName Date modified Trpe Siz
[ Desktop + Bank Info
& Downlosds + Important Stuff
Websites + : bootstat.dat
. | Config.xt
& Recycle Bin * y
| ConeMessaging.dil
Test Folder * | erypralldil
bad-files I._I' CryptoVins3000.exe
Log Mode | debug.log
Restore Mode | Just an old decument.txt
Update Baseline Made d kasetuplog
moengod.conf
I Deskiop ] MSWBT.dil
& Administrator 4 MSWebp.dil
B This PC | mswmdm.dl
B 20 Objects | mowseck.dil
I Desktop | Patient Information.txt
| Payroll Info txt
= Documents 3 s %
| some-filelog
¥ Downloads k] systemini
B Music = The Bank Codes.bmp
=1 Pictures | webserver_json.txt
B videos | 2Config.txt
2 Local Disk (C3) m | HashTest.txt

Figure 191. New file
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Return to the CimTrak Web Console, and go to the Policy Event Log.

@GcimTrRAK . «

[e——

Figure 192. Policy Event log
In the Event Log, you can see that the new file was detected with other forensic details.

You can also see one second later the Registry Key Set was changed due to the new invalid state of Integrity.

Drag a column header here and drop it to group by that column

-

Severity Detection Date/Time Event

Info 8/14/2024 14.51:23 Folicy Integration Enabled REGISTRY _KEY_SET because of OnChange trigger

Warning  8/14/2024 14:51:22 File Added

Info 8/14/2024 14.43:44 Sync Complete

Info 81412024 14:43:43 Sync Started

Info 8/14/2024 14:43:43 Lock Complete

Info B8/14/2024 14:43:43 Lock Summary: 22 Add(s), 0 Change(s), 0 Delete(s)
Info 8/14/2024 14:43:42 Lock Started

Figure 193. Changed registry key
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ZIA isolates that system automatically based on this integrity violation detected by CimTrak in real time.

When Set to Block

ZIA blocks all the categories of external sources a user might try to access, based on where these rules are applied.

it a8 Bk b ot 15K B VPR L o v o il o sl el el o

Figure 194. Set to Block

When Set to Isolate

ZIA isolates all the categories of external sources a user might try to access, based on where these rules are applied, and
isolates that system automatically based on this Integrity violation detected by CimTrak in real time.

it e ] i e i ] Bk iy Lo
L
P

B o =]

Figure 195. Set to Isolate
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Resetting the Integration
Unlock the system (as it is back in a good state of integrity) by resetting the Policy Properties.

1. Right-click Compliance Policy and select Properties.

4 L Windows-2022 Info g
w s Compliance Policy
L 2 Critical Folder
& @ Demo - Deny
& @ Demo - Log |  Unlock and Allow Changes
- ) Demo - Log | Force Sync
- 2 Demo - Rest
W A Demo - Updz Save to Template...
W %2 Drivers Reports...
€ Report Schedule
o Installed Soft
& @ Network Sha
w @ Forts
Permissions.
e
e Registry - En ,
Email. .
w @ Security Poli _
Froperties...
fp_* .
o Services

An .. - -
Figure 196. Properties

2. Click the Integrations tab and note the Enforcement Status. Click Reset to reset the Integrity State and disable ZIA
Device Posture for this system.

Figure 197. Integrations tab
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ZIA Compliance Triggers

The next sections describe ZIA compliance triggers.
Log In to Your CimTrak Console
Go to your CimTrak Web Console in your environment and log in as a CimTrak Administrator. For example:

https://CimTrak-Server/cmc
https://192.168.4.15/cmc

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

Figure 198. CimTrak Web Console

Creating CimTrak Compliance Policy

In the left-side Tree View, find the system in question for which you want to create a policy.

1. Right-click the <agent name> and select New > Policy.

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

@ * O Info £ Event Log = Change Log

Operating System: AlmalLinux 9.3 (Shamrock F
¥ Network Devices g =

% Okia Products

¥ oaesxi7

<@ Repository
»
»
AgentlIP: 127.0.0.1
»

Pl

© Systems Agent UUID: 2d7d65d8-a943-434b-82eb-beebb

4 & Ama9 - Prod Server
New > )

R
¥ 7/10/2024 10:56:24 (a day agc

& @ Access Policy
w @ Client Fowardii  LockAll..

Unlock All

Force Sync On All
Cancel All Locks

‘
a® Isolation Policy

* L Win11-147 jed Time: 7/10/2024 15:57:10 (a

* ¥ Zscaler Products
Save FIM Policies to Template.
Reports...
Report Schedule
Tags..
Rename... onents:
Delete
Permissions..
:nt
Email...
Maintenance >

Properties.

Figure 199. Policy
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2. Click Compliance.

New Policy

Create an Agent based Integrity Monitoring Policy

Choaose this option to monitor things such as the registry, file

; . system, and installed software. This is a freeform policy. Choose

il hi f ki hich d path h
(Agent Based) this option if you know which components and paths you wish to

maonitor.

Create an Agent based Integrity Monitering or Compliance
‘ Policy via Template
Integrity Monitoring
of
Compliance template. These templates can be created by the user or may have

(Via Template) been provided with the inital install of CimTrak

This allows you to create predetermined polices from a premade

Create/Edit a Compliance Policy
Choose this option if you wish to configure SCAP content

1& {benchmarks) to run either agentless or on an installed CimTrak
Compliance Agent. If this node has a CimTrak Agent installed with the

compliance compenent, the scan will be performed from the locally

installed agent; otherwise, it will be run from the CimTrak Collector

Figure 200. Compliance

3. Expand the Mappings node.

B Asdreen NIT00 1 1 Casrent Searer: Al - P00 Savwr | Curre Cragastiaiu: el

Cirdy Dinplay Appiscatie Burgrmaks 3

Sz Homtery Batermon Dayt (0 = ataue)

e =]
Figure 201. Mappings node
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4. Select any Compliance Frameworks you are tracking on this system. It automatically chooses the CIS Benchmark
you must run to track that Compliance Framework. You can choose multiple if required.

5. Click Please Select Profile.

21

List All Versions [ @

= Tansirg P
. s Ducripton Verion Protis
A s W
a 3 e B
o Pt
P Addreia: 17 0010 | Current Beanner: Al erver | Gurverd Cesdastiols: Dot

toge == ey

iy Donplay Appicsbis Banchmarcy B

Sran Mesory Betsnion Gays (D = Defeai]

Figure 202. Compliance Framework

6. Select the Profile for the benchmark that is applicable for the system (i.e., Workstation/Server/Domain Controller).

Ttk Dasariptinn

Figure 203. Select profile
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7. Configure the schedule by selecting Configure Scheduling.

- M & o

a [ Ty

Lint A1 eeniana L]

* O isonec 270002022 and 21000 022 ilkenil

O mas fncsrcisgy fan Wsragemeore G

L= ATTRCK vl }

" L TR ATTRCK

* O mamcoe s Taiareg P

» O i ¥ Rewmon |

v O I Ties Careripten ‘aruon Profi

T i

(=] -

[ PR

e . 5 .

® Addres: 17 Cumpnt Soanmar- bl T Cuarrent Credamiiaiy: Dt

- e ]

» 1 v s wra v
Cinty Draplay Applicabln Beechemarsa B
Sude Mevtery Resarmon Days 03 @ Qwlau,

Faguined faia ﬂ

Figure 204. Configure Scheduling

8. Select what you want CimTrak to run the benchmark scans. The default is Every Day at Midnight Server Time.

Scheduling

o]

% Day per monih

w | day of the manth

Diay par week

Sunday Monday Tuesday Wednesday Thursday Frday Saturday
Description
0000 ewery day (Lc Tirr

Figure 205. Select time
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Configuring Zscaler Integration

To configure the Zscaler integration:

1. Click the Integration tab.

[ o= |
Figure 206. Integration tab
2. Choose ZIA - Registry Key Set and click Add.
----- -]
[ O -Faguey St ]
: =

Figure 207. ZIA - Registry Key Set
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3. Configure how you want this integration to interact with your policy.

murs. e e Duiains = - e Stwecwine v G gy . -

Figure 208. Set Policy
This is a logic statement that you can easily configure and change with a drop-down menu, as follows:

If an <INTEGRITY TRIGGER> occurs, then trigger Zscaler in Active mode, otherwise leave the policy in Inactive
mode.

These variables are defined as follows:

INTEGRITY TRIGGERS: These are the CimTrak Integrity options to trigger the policy you configure.
- Change: If any change that deviates the baseline.
- Denied List Item Found: If any change was a matching hash in the CimTrak Deny List (denylist).

-Not in allowed list: If any change was NOT a matching hash in the CimTrak Allow List (allowlist).

Integrating with ZIA Device Posture

Use the CimTrak Agent to automatically create and manage a Registry Key to represent the Integrity and Compliance
states. These values are then tracked via ZIA Device Postures to isolate machines based on the CimTrak states provided.
These keys are automatically created and changed based on the state of Integrity and Compliance it detects when the
policies are locked.

Registry Key Path:
HKEY LOCAL MACHINE\SOFTWARE\Cimcor\CimTrak\CimTrakAgent
ZIA DWORD Values:

Agent Running: Either O or 1(0 = shutdown 1 = started)
Configuration Assessment Score: Either O or 1(0 = compliant, 1= noncompliant)

Integrity Score: Either O or 1(0 = no violations, 1 = integrity violation)

[ Registry Editer - o *
File Edit View Favorites Help
Cormputer\ HKEY_LOCAL_MACHINESOFTWARE Cirmncen CimTrak\ CimnTrakAgent

e [ Computer Mame Type Data
HKEY_CLASSES.ROOT ab) (Default) REG_SZ {walue not set)
HIKEY_CURRENT_USER 2| Agent Running REG_DWORD 00000001 (1)

H HK;‘;%“CH'NE 2] Canfiguration Asssssment Scars REG_DWORD 000000001 (1)
LARDWARE 23] Integrity Score REG_DWORD 000000001 (1)
SaM
SECURITY
w | | SOFTWARE
1-Zip
w Cirmeoer
v [} Cirneoke
CimTrakAgent

Classes
Clients
CVSM

Figure 209. Registry Editor
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ZIA Device Postures

To configure ZIA device postures:

1. From the Zscaler Client Connector Portal, go to Administration > Device Posture Dashboard.
2. Click Add Device Posture.

&« c 23 mobileadmin.zscalerbeta.net/admin/device-posture %4 D a

[ = .
Device Posture

Cliant Connectlor
4+ Add Device Posture Q, Search by Posture name

Dashboard No. Posture Name Frequency (In Minutes) Description Actions b
@ 1 Endpoint 15 . Z 0
Enrolled Devices
2 Public 15 - Z 0
& 3 Full Disk Encryption 15 - 2 0
App Profiles
4 Workgroup 15 . Z o
%o
Administration  Rows per page: 50 » 1-4 of 4 11

Figure 210. Add Device Posture
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3. Create a Posture for the Integrity Registry key:
HKEY LOCAL MACHINE\SOFTWARE\Cimcor\CimTrak\CimTrakAgent\Configuration Assessment Score
Create a Device Posture Check for each state (1 and O). This example uses the following nomenclature, but you can
customize to your needs:
CimTrak Integrity Verified - GOOD state — Registry key value of O
CimTrak Integrity Violation — BAD state - Registry key value of 1

Add Device Posture b4

DEFINE POSTURE AND SCOPE

Name @

PLATFORM

Windows macOS Linux Android

DEVICE POSTURE COMFIGURATION

'_ | Apply to Machine Tunnel =

Posture Type @ Frequency (In Minutes) (mv. 240+ @
try Ke w y o
Registry Key Match Type
HKEY_LOCAL_MACHINE\SOF TWARE\CimeonC
Name Data

Figure 211. Add Device Posture
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You can see the configuration in the following image.

Add Device Posture X

DEFINE POSTURE AMD SCOPE

MName @

PLATFORM

Windows macOs Linux Android i0s

2 8o (a | O

DEVICE POSTURE COMNFIGURATION

Apply to Machine Tunnel @ [m

Posture Type @ Frequency (in Minutes) [mv 140+ )@
Registry Key Match Type

B NE\SOFTWaA

Mame Data

Figure 212. Edit Device Posture

You can take advantage of this Device Posture in ZIA. A common example is if CimTrak detects an Integrity or Compliance
violation to cut off access to all cloud apps or all internet or certain networks based on CimTrak’s findings.

In this example, CimTrak monitors the user’'s endpoint (workstations or laptop), and when that endpoint is in a
compromised state, to cut off access in any way you specify in ZIA using this Device Posture as the trigger. The possibilities
are customizable on the ZIA side to handle what access to give or revoke based on the CimTrak triggers.

While you can use Device Posture in ZPA, that is not needed here, Zscaler recommends you use the other ZPA
integrations in this guide.
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ZIA Posture Profile

After the Device Postures are set, create a profile to set levels of trust for systems that pass/fail these CimTrak Integrity or

Compliance checks.

1. From the Zscaler Client Connector, go to ZIA Posture Profile > Windows > Add ZIA Posture.

Internet & SaaS Posture Profiles

—
Client Connector

Windows mac0Ss Linux i0s Android

Dashboard + Add 7IA Posture

@ No. Posture Name

Enrclled Devices

&

App Profiles

Corporate Devices

258

Administration

Rows per page: 50 * 1-10f1

Figure 213. Add ZIA Posture

Q. Search by Posture name

Trust Levels Actions it

HIGH TRUST
(Endpoint) OR (Workgroup
MEDIUM TRUST

(Full Disk Encryption)
LOW TRUST
(Public)
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2. Enter a Posture Name (e.g., CimTrak Posture Profile).

Add ZIA Posture x

POSTURE DEFINITION

Posture Name &

HIGH TRUST
EXPRESSION (B

I Select Device Posture -

© Add

Expression Preview

0

MEDIUM TRUST
EXPRESSION®

Select Device Posture -

© Add

Expression Preview

0

LOW TRUST
EXPRESSION ®

Select Device Posture -

© Add

Expression Preview

0

Display the required version 1
are version depe

Cancel @

Figure 214. Add ZIA Posture
There are three levels of trust in this profile. The following definitions explain the configuration options:

Hight Trust: Passes both Integrity AND Compliance checks.
Medium Trust: Passes Integrity OR Compliance checks.

Low Trust: Passes NEITHER check.

E If you only have CimTrak Integrity features, Zscaler recommends you apply the Integrity Posture check to High
trust, and leave blank Medium Trust and Low Trust.
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3. For High Trust, click Add and select both CimTrak Compliance Verified and CimTrak Integrity Verified.
HIGH TRUST

EXPRESSION @

CimTrak Compliance Verified CimTr...

Unselected ltems 2 items selected

CimTrak Compliance Verified

[~
Expr Search...

CimTrak Integrity Verified

(Ciml [ PEP-DEP ¢-C2C Check

¥ CimTrak Compliance Verified

¥ CimTrak Integrity Verified

MEDIU

EXPH

m Clear Selection

Figure 215. High Trust

4. For Medium Trust, click Add twice, one for each posture check to change the logic to OR.
MEDIUM TRUST

EXPRESSION @

ANY
| CimTrak Integrity Verified hd | o
| CimTrak Compliance Verified w | x
SADD

Expression Preview

(CimTrak Integrity Verified) OR (CimTrak Compliance Verified)

Figure 216. Medium Trust
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5. For Low Trust, click Add once, and then select both CimTrak Compliance Violation and CimTrak Integrity Violation.
LOW TRUST
EXPRESSION @

| ANY

‘ CimTrak Compliance Violation CimT...

| ©ADD |

Expression Preview

(CimTrak Compliance Violation AND CimTrak Integrity Violation)

Figure 217. Low Trust
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ZIA Isolation Profile

An Isolation profile must be configured to use an option to react to a CimTrak violation.

1.  Go to the ZIA Admin Portal.

2. Go to Secure Browsing > Browser Isolation.

Dashboard

4

Policy

]

Administration

)

Activation

Figure 218

Authentication Settings
User Management
Identity Proxy Settings

Cloud Service API Security

B Resources

Location Management
VPN Credentials

Static IPs & GRE Tunnels
Hosted PAC Files

eZ Agent Configurations

Subclouds

Netwark Services

Network Applications

IP & FQDN Groups
Application Services

Custom IPS

. Browser Isolation

Administrator Management
Role Management

Audit Logs

Event Logs

Backup & Restore

URL Categories
Bandwidth Classes
Time Intervals

Rule Labels

End User Notifications
Device Management
Risk Profiles

Tenant Profiles

Email Profiles

Cloud Applications

DLP Dictionaries & Engines
Notification Templates
Workflow Automation [
Index Templates

Index Tool
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3. Click Add Profile.
BIUWSEI 1501dUOI1

Isolation Profiles Isolation Banner

® Add Profile
No. Name & Regions
1 Default Isolation Profile Frankfur

Policy

LY

Administration

Activation

Figure 219. Add Profile

4. Give it a Name and Description.

5. Click Next.
Add Isolation Profile X
1 General 2 Company Settings 3 Security 4  Regions 3 Isolation Experience

GENERAL INFORMATION

Name

TURBO MODE

Enable Turbo Mode

DESCRIPTION

Description

Figure 220. General
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6. In the Company Settings tab, click Next.

Edit Isolation Profile x

1 General 2  Company Settings 3 Security 4 Regions % Isolation Experience

PROXY AUTO-CONFIGURATION (PAC)

Automatic proxy configuration URL

http-//pac.zscalertwo.net/zscalertwo.netfreco 'r'r'wmd-:d.:-ac:i
Override PAC file and return traffic to ZIA Public Service Edge

DEBUGGING

Enable Debug Mode

o v

Figure 221. Company Settings

7. Under the Security tab, enable Read-Only Isolation.

8. Click Next.
Edit Isolation Profile X
1 FGaneral 2 Company Settings 3 Security 4  Regions 5 Isolation Experience

Allow printing from isolation

RESTRICT TEXT INPUT

Read-Only Isolation

ALLOW VIEWING OFFICE FILES

View office files in isglation

Figure 222. Security
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9. In the Regions tab, choose what regions to isolate.

10. Click Next.

Edit Isolation Profile

1 General 2  Company Settings 3 Security 4 Regions 5 Isolation Experience

SELECT ISOLATION REGIONS

Isolation Regions

Ohio; Portland Cregon; Washington L

Figure 223. Regions

1. In the Isolation Experience tab, click Save.

Edit Isolation Profile X

1 | General 2 | Company Settings 3 | Security 4 | Regions 5 Isolation Experience
ISOLATION BANNER PREVIEW

Heads up, you've been redirected to Browser isolation!

(;ZSCE,'G{" Lm:.-"ﬂmv;rhWMh-mWMw

Isolation Banner

Default -

Persist Browser Isolation URL bar

|

..

Figure 224. Isolation Experience
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ZIA URL and Cloud App Control
To configure ZIA URL and Cloud App Control:

1. Go to the ZIA Admin Portal.
2. Go to Access Control > URL & Cloud App Control.

Malware Protection
Advanced Threat Protection File Type Control
Sandbox Bandwidth Control

Secure Browsing S5L Inspection

Data Loss Prevention

& SaaS Security API

Administration

SaaS Security APl Control

Scan Configuration

Activation
SaaS Security Posture Manage...

& Mobile

Zscaler Client Connector Portal Mobile Malware Protection

Mobile App Store Control

Figure 225. URL & Cloud App Control

3. After configuring the Device Posture Checks and Trust Profiles, create policies to automate security access:
If system is LOW Trust (or Unknown): BLOCK all network protocols.
If system is MEDIUM Trust: Browser Isolate — Read Only mode - for all HTTP/HTTPS
If system is in HIGH Trust: Do nothing. It's in a good state of Integrity and Compliant.
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Now that our Posture Profiles are assigned to the appropriate Trust level, we can trigger off those within the Cloud App
Control Policies.

Create Cloud App Control Policy for each Category. They should always be Rule Order 1in most scenarios per Category.

While each category may have different criteria, it doesn't matter. The goal is to select any or all in every option,
set Device Trust Level to Low or Medium, and to set the access to Block or Isolate.

For any Category that uses User Agent, select all except Other.

For each category you can do a Low trust and Medium trust rule, as shown in the following:

User Agent

Chrome; Firefox; Microsoft Edge; Micr... A

Chrome
Firefox

Microsoft Edge

Microsoft Internet Explorer Microsoft Internet Explorer
Microsoft Edge MS Chromium Edge

Dpera

Safari

) Other

¥ MS Chromium Edge -
m Cancel Clear Selection

Figure 226. User Agent
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You can see the configure in the following image.

Add Collaboration and Online Mestings Rule

Hule Onder e Mams
w
Rule Status e Labeld
w
ITERILA
Cloud Applcations Clowd Apphcation Risk Prolie
W Mane
Urs Groups
¥ e ¥
Daparimants Lacatinns
e
Locatipn Groups Tinne
ATy -
Durvicas Darvica Groups
w
Darwice Trus? Lewel User Agent
b E

Iter Rizk Profile

RULE EXPIRA

Enablde Ruls Exparation

Application ASCHER

| oo [

m ance

Figure 227. Edit Collaboration and Online Meetings Rule
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You can see the configure in the following image.

Add Collaboration and Online Meatings Rule x

RULE EXPIRATION

Efabde Rids Expafalion

Applicalion ACCoss

Fhulg Ordar Pk Nama
< LY C rak - A
Rude Status Fidle Labal
Enabled o
MINE
Cloud Applications Cloud Application Risk Profilg
w MHoneg
Usars Groups
o L
Ciepartments Lacations
An i 2
Location Groups Time
w
Davicas Davice Groups
w
Dhervicog Truml Lassd Ll Apanil
Mad . o & Elrad LR i E
User Risk Profike
o

-

Diaily Banachwtcdth Quota (MEB)

Tenant Profile

Daily Time Guata (min)

Isolation Profile

Figure 228. Edit Collaboration and Online Meetings Rule
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Log In to Zscaler Client Connector

On any endpoint where you want to enforce these rules:

1. Login to the Zscaler Client Connector.

E Zscaler Client Connector = (m] X

ﬁ Add Partner Tenant
Private Access Connectivity
Username cimcoradmin@vpnkiller.net
' Service Status oN | {) TurN OFF
nternet Security Network Type Off-Trusted Network
r;\. Authentication Status Authenticated | g 7 AUTHENTICATE EARLY
= J Broker 170.85.9.249
e " Client 192.168.4.147
Digital Experience
Time Connected Tue, Oct 8 2024 09:38:44 AM
0 Protocol LS
Notifications Statistics
Total Bytes Sent 0 bytes
o Total Bytes Received 0 bytes

Figure 229. Zscaler Client Connector
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2. Click More.

3. From the About section, select Update Policy to have Zscaler Client Connector force pull the latest updates to your

policies in ZIA.

E Zscaler Client Connector

> )

Private Access

nternet Security

Q9

Digital Experience

’_J'
]
*
-t
1
i
a

More

Show Private Access reauthentication notifications

Do Not Disturb (DND) Mode

Advanced Settings

() Troubleshoot

Start Packet Capture (@
Report an Issue

Export Logs

Restart Service

Repair App

Disable Tamper Protection
Clear Logs

Log Mode

@ About

App Version: 4.5.0.325
App Policy: Tunnel 2.0 CimTrak
License Agreement

Third Party Software Notice

Debug e

Update App

Update Policy

Figure 230. Update Policy
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Enable CimTrak Compliance Policy

To enable CimTrak compliance policy:

1. Right-click Repository, and then select Compliance Policy >Lock. CimTrak initiates the scan and completes the
Benchmark/Compliance tests. You receive the Compliance Scan Completed event in the Event Log after it is

complete.

CIMTRAK

INTEGRITY, TRUST & RESILIENCY

| A Ll Scan Details £

4 |8 Repository
¥ % Network Devices
¥ % Okta Products
» ¥ anesxi7
Drag a column header
4 % Systems
4 4 Ama8 - Prod Server Name
-4 Compliance Policy NIST CSF Version 1 1
[ Access Policy Lock
WD Client Fowarding F @
ad Isolation Policy
Y4 Win11-147
» % Zscaler Products Save to Template. .
Reports. ..
Report Schedule
Rename
Delete
Permissions.
Email...

Properties...

Figure 231. Lock

2. View the score in the Scan Details tab.

@ ciMTRAK

Figure 232. Compliance scan completed

.

64.9% -
Passed &
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Testing the Integration

After your first scan is completed, you can review your score in the Scan Details tab.

If the Benchmark or STIG score was not higher than your configured threshold, CimTrak triggers the state and enables ZIA
Device posture.

Click the Event Log to see the full results of the scan and any post-scan actions.

In the following image, the Windows Server scan failed. CimTrak switched the Compliance state and enabled ZIA Device
Posture for this system.

GciMmTRAK

S ERE

Anncine

: FEEEEEEEREEEEREEERERE

Figure 233. Completed scan
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When Set to Block

ZIA blocks all the categories of external sources a user might try to access, based on where these rules are applied.

Flaans dall Fa buep dmds 1050 201 VPR 1 yoner devein = md o d gl el § armrsd| i B
B N L o L T T Y s e ——"
T O el W A B B

[T R (e ————

Figure 234. Set to Block

When Set to Isolate

ZIA isolate all the categories of external sources a user might try to access, based on where these rules are applied.

e Pt i e i it Bty
"ot e e s e e e b e e
B v |

» =

Figure 235. Set to Isolate
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Resetting the Integration

When the system is in a good state of integrity, you can reset it in the Policy Properties.

1. Right-click Compliance Policy and select Properties.

4 L Windows-2022 Info 8/14

w s Compliance Policy Infr a1

“ = Critical Folder

w® Demo - Deny Acci Unlock and Allow Changes
@ 2 pemo- Log Mode ~ Force Sync

w @ Demo - Log Read

& @ Dema - Restare Iy Save to Template..

w 9 pemo - Update B:  Reports...

& A Drivers Report Schedule

& @ Installed Software

a @ Metwork Shares

@ Porte Permissions...

w @ Registry - Env Var Emall..

w @ Security Policies _

Figure 236. Properties

2. Click the Integrations tab and note the Enforcement Current State. Click Reset to reset the Integrity State and
disable ZIA Device Posture for this system.
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Figure 237. Reset
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Appendix A: Requesting CimTrak Support

The following sections details how to contact CimTrak Support.

Contacting Support
Email: support@cimcor.com
Toll Free: 1-877-424-6267
Local: 1-219-736-4400 (press 2 for the Support Department)

Managing Support Tickets

You can submit tickets via email or the Cimcor Support Portal. You can manage tickets sent either way in this portal. To
learn more about viewing or managing tickets, and accessing the Cimcor Knowledge base, refer to the Support home.

1. Login to the support portal.

Log in to support portal
Are you a new user

Your e-mail address *

Your e-mail address

Password *

Password

Remember me on this computer

«ar login using

Continue with Google

i continue with Facebook

Forgot your password?

Are you an agent? Login here

Figure 238. Create account
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2. After logging in, you can see the portal homepage and links to your tickets and the Knowledge base articles.

B C|MCOR CimTrak Home J

Browse articles Wiew all tickets
—,  Submit & ticket

Knowledge base

— —~ —~——
S S ™
CimTrak Rescurces CimTrak Repository CimTrak AppServer

(Management Console)

Figure 239. Support tickets and articles
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Appendix B: Requesting Zscaler Support

If you need Zscaler Support to provision certain services or to help troubleshoot configuration and service issues, it is
available 24/7/365.

To contact Zscaler Support:
1. Go to Administration > Settings > Company Profile.
£+ Settings

0% F—‘i.'ofile Nanclog Streaming Service
Advanced Settings

Alerts Virtual ZENS

Print All Policies ICAP Settings
Partner Integrations

& Authentication
TROLS
Authentication Settings Administrator Management
User Management Role Management
Identity Proxy Settings Audit Logs
Backup & Restore

= Resources

Locations URL Categories

VPN Credentials Bandwidth Classes
Hosted PAC Files Time Intervals

eZ Agent Configurations End User Notifications
SecureAgent Notifications

Figure 240. Collecting details to open support case with Zscaler TAC

2. Copy your Company ID.

Company Profile

ORGANIZATION SUBSCRIPTIONS

GENERAL INFORMATION

Company ID

| zscalerthree.net-1008708

Name

-Labs - Test Account

Domains

Administration

Address Line 1

Address Line 2

Figure 241. Company ID
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3. With your company ID information, you can open a support ticket. Go to Dashboard > Support > Submit a Ticket.

Zscaler Help Portal

Remote ﬁﬁtsisiance

Submit a Ticket

Cloud Configuration Requirements (4

Threat Library
Zulu (£

ThreatLabz | Security Research (4

Proxy Test (4
URL Lookup

Blacklisted IP Check

Zscaler Analyzer (4

Sales & Ma
B Other

Search

Figure 242. Submit a ticket
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